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Logger Pro Overview
 The Logger Pro user’s guide is divided into four main sections: this
overview, a How To section, a Teacher’s Guide, and the Logger Pro
Reference. This Overview concludes with quick-start instructions for
the eager. Instructors using Logger Pro in the classroom will want to
read the Teacher’s Guide for helpful tips. The How To section explains
common operations with Logger Pro. It is designed to be read in any
order. The Reference Section explains the function of all the menu
items and how to use them. On-line help is available: Choose Help from
the Apple menu (Macintosh) or the Help menu (Windows).

 The Logger Pro tutorials are stapled separately from the user’s guide
for ease of duplication. We suggest that you read one or both of the
introductory tutorials to learn more about Logger Pro. One introductory
tutorial focuses on using a temperature sensor with Logger Pro, and is
written for integrated science, chemistry and biology students. The
other introductory tutorial uses the Motion Detector and is written for
students who will study motion. Additional tutorials teach more
advanced skills such as data analysis, curve fitting and defining new
columns.

 Initial software installation and the connection of the interface are
explained in the Teacher’s Guide. Refer to the troubleshooting chart in
Appendix A if you have problems. Detailed information for network use
can be found in Appendix B. Appendix C reviews the interfaces that can
be used with Logger Pro, and how to choose between them. A
comprehensive list of the sensors compatible with Logger Pro is in
Appendix D.

 Some familiarity with the use of the Macintosh or Windows and
application software is assumed in this manual.

 Logger Pro, for use with any Universal Lab Interface (ULI) and the
Serial Box Interface, has been designed by Rick Sorensen, Dave
Vernier, John Wheeler, David Gardner, Dan Holmquist and John
Gastineau of Vernier Software, and by Ronald Thornton and Stephen
Beardslee at the Center for Science and Mathematics Teaching at Tufts
University. The design was implemented by Stephen Beardslee, Nam
Hoang, Mary Dygert, Patrick Powers and Zachari Partridge.

 Logger Pro is a copyrighted program by Tufts University and Vernier
Software. The program disk does not use any copy protection, and back-
up copies may be made using standard procedures. Purchasers of
Logger Pro are permitted to make as many copies of the program or
manual as they wish for use within their own middle school or high
school, or within a single college department. The program may also be
used on network systems at no extra cost, provided that the software is
used within one middle school or high school or one college
department.

 The Logger Pro manual is copyright ©1999 by Vernier Software. This
manual was written by John Gastineau.

Macintosh is a registered trademark of Apple Computer, Inc. Microsoft,
Windows, Windows NT, and Win32s are either registered trademarks or
trademarks of Microsoft, Inc.

Overview

Logger Pro,
the Universal Lab Interface
and the Serial Box Interface
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Logger Pro Quick Start

 This section is provided for those who do not read software manuals. It
outlines the essential steps to get started with Logger Pro.

� Insert the floppy disk into your computer and run the installer
program.

� Accept the default suggestion for file location.

� Attach either a ULI or a Serial Box Interface to the computer using
the supplied cable. On the Macintosh you can use any serial port,
including the modem and printer ports. On the PC you can use any
of the COM1, 2, 3 or 4 serial ports.

� Attach the power adapter to the interface and to a source of 115VAC.

� Attach a sensor to the interface. For example, attach a sensor with a
DIN (round) connector to the first port, or a Motion Detector with a
telephone-style connector to Port2 (ULI only).

� Locate the Logger Pro icon and double-click on it, or use the Start
menu (Windows 95/98). You should see the following screen on
your monitor.

 

Purpose

Install software

Attach interface and sensor

Start up Logger Pro
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� Choose Open from the File menu, and choose an experiment file
from the appropriate sensor folder. For example, if you will use the
Barometer, look inside the folder Barometer for the barometer
experiment files. Calibration is automatically loaded with the
experiment file.1

 

� Click on the Collect button on the screen. Logger Pro should begin
plotting data in the graph window.

 You can adjust most features of the graph by double clicking the graph
and making changes in the resulting dialog box.

� First, select a portion of the graphed data by dragging across
it.

� Then click on the linear fit button on the toolbar.

 If you need more information for using Logger Pro, remember that
there is a manual and extensive on-line help.

                                                     
 1In Windows 3.1 folder and file names will be truncated to eight characters. For
example, the Barometer experiment file will appear as BAROME~1.MBL.

 Configure Logger Pro for
your sensor

 Collect data

 Adjust graph

 Insert linear regression line

 

If you need more
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Tutorial Overview
 The Logger Pro package includes six short tutorials for first-time users,
either students or teachers. They are suitable for reference or for
duplication and distribution to classes. First-time users should work
through one introductory tutorial and the advanced tutorials as needed.

 The tutorials are bound separately from this manual for easy
duplication.

 The first two tutorials, Temperature Measurement and Motion
Detection, are both introductions to using Logger Pro. Temperature
Measurement can be used by all students, while Motion Detection is
intended for physics or integrated science students.

 The remaining tutorials are intended to be read after either of the first
two tutorials are completed, and provide instruction on performing
specific tasks with Logger Pro. These tasks include

• analyzing data and changing what is graphed

• fitting curves to data

• saving files and printing or transferring data

• creating new columns for data

 The advanced tutorials can be done in any order.

 The tutorials assume that Logger Pro has been installed and an interface
(a ULI or Serial Box Interface) is properly connected to the computer.
Installation instructions are located in the Teacher’s Guide.

 

Purpose of tutorials

Introductory tutorials

Advanced tutorials

Preliminary setup
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 How To
 In the How To section you will learn to perform specific functions in
Logger Pro, such as using a new sensor or changing data collection
rates. You don’t need to read this section straight through—just jump to
the task you want to perform, and read that portion. The tasks are
organized in seven broad categories: graph appearance, sensor
functions, data collection options, non-graph windows, data analysis,
data tables, and saving and printing data.

 If you have further questions, go to the reference section and read the
descriptions of the relevant menu items, or check the index for other
references.

 Change Graph Appearance

 There are many ways that you might want to change the appearance of
the initial graph. The range of the x or y axis might not be ideal. Or, you
might want to plot other quantities on each axis. You can change most
elements of the graph directly by clicking on them, so if you are not
sure how to change a given item, begin by clicking on it and see what
happens. Here are some things you can quickly change on a graph.

 Often you will measure some quantity and the plotted line will only fill
a portion of the screen. You can quickly change the range of values
plotted by clicking the numbers at the ends of the graph axes. Type a
new value and press enter.

 To make the plotted data fill the graph window, click the
Autoscale button on the toolbar.

 To change just the x- or just the y-axis limits, click on the desired axis.
You will see a dialog
box:

 Choose the type of
scaling you want.
Autoscale will set the
axis limits so the data
just fill the axis. The
origin may not
necessarily be
included unless you
choose Autoscale
from 0, in which case
the origin is always included. Manual scaling allows you to enter the
minimum and maximum limits manually. The choice made here will
determine how Logger Pro scales a new graph.

 To enlarge a portion of a graph to fill the screen, drag across the
desired area with the mouse, leaving a rectangle on the graph
enclosing the area of interest. Then click on the Zoom In button
on the toolbar. If you don’t like what you see, you can reverse
the action by clicking the Undo Zoom button.

 The Zoom Out button will double the range of both the x and y
axes. It does not undo a Zoom In—Undo Zoom does that.

 

 Change axis limits manually

 Change axis limits
automatically

 Zoom in on a graph
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 Sometimes the plotted data will extend off the screen. The arrows at the
ends of the vertical and horizontal axes can be used to scroll across the
data. Using the scroll arrows is equivalent to changing both extremes of
the axis limits at the same time while maintaining the same interval
between extremes.

 The default plot will usually be the sensor output as a function of time
or a prompted input. You may want to plot some other quantities. Click
either on the x- or y-axis label to get a check box list of all the possible
quantities for plotting. Some combinations will not be useful. If you
don’t see what you want to plot, you may be able to create a new
column of data based on the raw data. See create new columns below.
Once you’ve defined a new column you can plot it.

 You can plot data from multiple sensors either on a single graph or on
separate graphs. To use a single graph:

� Click on the y-axis label and select all the sensors you want to plot
together. Click on OK

 To use several different graphs, you need to create the needed number
of graph panes:

� Choose Graph Layout from the View menu.

� Click on the layout with the desired number of panes.

� For each graph click on the axis label for a list of available columns
for plotting. Choose the column of the desired sensor.

 Sometimes it is appropriate to plot the value of one sensor versus
another. For example, you might want to graph pressure as a function of
temperature. Once Logger Pro is set up to simultaneously take data for
the two sensors, click on the axis labels to select the appropriate
quantity. A graph does not need to include time.

 This feature is not available in the current version of Logger Pro.

 The axis labels are shown with physical units whenever they are
available. When you set up a new sensor, you can enter the desired units
at the same time that you perform calibration. For more information see
sensor setup below.

 If you double-click on a graph, you will get a dialog box that allows you
to change a number of graph options. Brief descriptions follow; for
additional information see Logger Pro reference.

 Scroll to a new portion of
graph without rescaling

 Change what is plotted

 Graph two or more sensors
simultaneously

Plotting one sensor versus
another sensor

Arrange windows

Change the units displayed

Change other graph options
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 The following functions are found on the Graph Options dialog. Double
click a graph to open this dialog box.

 Select point protectors as desired. A point protector outlines a data
point. You may want to outline every 5th or 10th point to keep the graph
from getting crowded.

 Adding a legend opens a floating box holding a key to the plotted data.

 Select the Connecting Line option to connect data points with lines.
Without this option selected individual data points are visible.

 When this option is selected a line is drawn from the horizontal axis to
each data point, creating a bar graph. You can control the width in
pixels. Setting the 3D checkbox adds simulated depth to the bars.

 Select or deselect the grid as desired. You can also adjust the line style
and color of the gridlines in this dialog box.

See data points directly (point
protectors)

Add/remove a legend

Connect data points

Bar graph

Add/remove the grid
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Configure Sensor Functions

 The best way to set up Logger Pro for a particular sensor is to open an
experiment file. Logger Pro comes with experiment files for each
Vernier sensor and for the books Physics with Computers, Biology with
Computers, Chemistry with Computers, Physical Science with
Computers, Real Time Physics, and Tools for Scientific Thinking. All of
these books are available from Vernier Software. The files load an
appropriate calibration, set data collection parameters, and prepare
Logger Pro for experiments with that sensor. Even if you want to use
your own custom configuration, these files are good starting points.

 Choose Open from the File menu. Initially you will see a list of folders
corresponding to the various books, the tutorials, and specific sensors.
Choose the experiment file from the scrolling list that matches your
sensor and application.2 If you are not working from one of the Vernier
books, we suggest that you open an experiment file listed by the sensor
name. Logger Pro is now ready to acquire data with the selected sensor.

 To set up Logger Pro for a particular sensor and experiment without an
experiment file, or to add additional sensors to that supported by an
existing experiment file, you will need to specify the sensor, input, and
calibration file to be used in the Sensor Properties dialog. As an
example, here is the way to configure Logger Pro for a temperature
sensor. Calibration instructions follow the initial setup.

� Attach the sensor to a physically compatible port.

� Choose Sensors… from the Setup menu or click on the interface
icon in the toolbar. (  or  )

 You will see this dialog box if you are using the ULI3; if instead you are
using a Serial Box Interface only two DIN inputs will be visible.

                                                     
2You may need to navigate through the directory structure of your hard disk to
find the experiment files. If the Logger Pro Preferences are properly set you
will immediately see the experiment files when you choose Open.
3If you are using an original ULI with a clear plastic cover, the DIN3 and DIN4
inputs will not appear.

Open an experiment file

Perform a
complete configuration
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 Next,

� Click on the port to which you attached the sensor. For example,
DIN1 if you attached the temperature probe to that input.

� Choose the sensor name from the Sensor scrolling list.

� Choose the desired calibration file from the Calibration scrolling list.
Some sensors have several possible ranges or units choices. In most
cases you will use the default calibration.

 In most cases you do not need to manually calibrate, for the supplied
calibration will be adequate. If you do not need to perform a new
calibration for the sensor, click on OK. You are ready to acquire data. In
cases where you do want to calibrate a sensor for additional accuracy,
follow the instructions immediately below.

 To calibrate a sensor you must have another way of measuring the
sensor quantity. For instance, with temperature sensors you will need a
separate thermometer as well as water baths of different temperatures.

 To perform a new calibration,

� choose Sensors from the Setup menu if the Sensor Setup window is
not already open.

� Click on the Calibrate tab at the top of the resulting dialog box.

� Click on the input or inputs to be calibrated. The selected inputs will
be outlined in black.

� Click on Perform Now.

� Allow the sensor and the thermometer to stabilize at the first cali-
bration temperature. You can determine this by waiting until the
input readings stabilize. The input readings are the raw voltage
signals from the sensor, and it is the relationship between the voltage
and temperature that is being determined by this calibration.

� Read the thermometer, and enter the reading in degrees into the
Value 1 field.

� Click on Keep.

Calibrate a sensor

 First calibration point
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� Move the sensor and thermometer to the second bath and allow them
to stabilize at the second calibration temperature.

� Enter the thermometer’s reading in degrees into the Value 2 field.

� Click on Keep.

 You may want to save the calibration result for later use.

 The calibration information is most easily saved by saving an
experiment file. The calibration information, along with all other
Logger Pro settings, is loaded when the experiment file is opened. We
recommend that you use the experiment file method of saving
calibration and experiment setup.

 If the calibration should be generally available any time a user selects
that sensor in the Sensor Setup dialog, then save the calibration
separately by clicking on the Save button.

� Click on Save to record the calibration to disk for later use, or click
on OK to use the calibration only temporarily.

 Calibration files are saved to the calibration directory set in the Logger
Pro preferences.

 To remove a sensor from a configuration so that data are no longer
collected from the input, choose Delete Column � (sensor name)
where sensor name is the sensor you want to remove. You can also click
on the Sensor Setup button  , then click on the input to be freed,
and choose None from the sensor list.

Second calibration point

 Save calibration

 Remove a sensor
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 Configure Data Collection Options

 The easiest way to configure Logger Pro for a particular data collection
mode is to open the appropriate experiment file. Experiment files for all
compatible sensors and common data collection modes are supplied
with Logger Pro. You can also configure Logger Pro manually.
Instructions for manual configuration follow.

 Choose Data Collection from the Setup menu. You will see this dialog
box.

 

 Select Real Time Collect from the scrolling list. In this mode data are
collected continuously at the rate indicated and for the time interval set
on the Sampling tab. To modify these settings, click on the Sampling
tab.

 Collect data in real time
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 To start new data collection runs repeatedly, select Repeat from the drop
down menu. Logger Pro will collect a data run, pause for a moment,
and then collect another run, overwriting the previous run. To stop data
collection, click on the Stop button on the Toolbar. If you miss the end
of a run you want to keep and Logger Pro starts taking data again, click
on stop, then choose Undo Collect from the Edit menu to return to the
previous run.

 

 In the Data Collection Sampling tab set the time units you want and the
Sampling Speed, i.e., the number of points collected each second,
minute, or other time interval. Sampling speed is a trade-off; too fast a
speed yields unwieldy data sets, while too slow a collection rate will
miss important experimental details. Logger Pro can collect at most
30,000 points in each input channel.

 Set the total time of data collection for Real Time Collect, Repeat and
Selected Events modes in the Data Collection Sampling tab. You can
also set the experiment length by changing the maximum time axis label
to the desired value.

 To set the units used on the time axis, choose between hours, minutes,
seconds, and milliseconds in the drop down menu.

 Collect data repeatedly

 Set sampling speed
(data collection rate)

 Set experiment length

 Set time units
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 The setting on the Averaging tab determines how many measurements
will be taken for each reported point. For example, if the sampling
speed is 10 samples/second and the averaging is set to 5 points, readings
will be taken 50 times a second (evenly spaced in time) and 5 will be
averaged to yield a single data point. Click OK to enter your settings.
Only analog sensor readings can be averaged. Digital readings such as
from the Motion Detector cannot be averaged.

 You can define a new, smoothed data column as a function of an
existing column using the smooth( ) function. Choose New Column �

Formula, enter a name, click the definition tab, and in the equation field
enter smooth(“column name”)  where column name is the name of the
existing data column. Click OK to create the new column. Smoothing
differs from averaging in that smoothing acts on an existing data
column and does not reduce the number of data points.

 To change the number of points used in smoothing choose Options in
the Experiment menu. The subsequent dialog box allows you to vary the
amount of smoothing. Excessive smoothing will obscure details in the
data.

 Set averaging

 Smooth existing data
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 The Triggering tab of the data collection dialog allows you to set trigger
conditions for data collection. When triggering is enabled in the
checkbox and the Collect button clicked, Logger Pro waits until trigger
conditions are met to collect data. If multiple sensors are in use, data
collection will begin when the trigger condition is met on any one of the
inputs. Only analog sensors can be used for triggering.

 

 

 To collect discrete data points rather than a steady stream of data,
choose Data Collection from the Setup menu. Choose either Events
with Entry or Selected Events from the drop down menu. In either
mode, after the Collect button is clicked a Keep button appears. A data
point is recorded whenever the Keep button is clicked; in addition if the
mode is Event with Entry you are prompted to enter values for a new
data column. For example, you might enter a volume, concentration, or
trial number. The labels for the prompted column are entered in this
dialog box.

 

 

 Trigger data collection

 Collect data point by point
(prompted)
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 To collect photogate or Smart Pulley data, choose Data Collection from
the Setup menu. Choose Photogate Timing from the drop down menu
on the Mode tab. It is not necessary to set any inputs using the Setup
Sensor dialog. The photogate mode supports seven methods of
collecting data. To see these modes click the Sampling tab:

 

 The available modes are: Motion Timing, Gate Timing - One Gate, Gate
Timing - Two Gates, Pulse Timing, Collision Timing, Pendulum
Timing, and Gate and Pulse Timing. Each mode is described below. The
diagram following these descriptions will help you visualize the various
modes.

 The Motion Timing mode uses a photogate or Smart Pulley connected
to the digital input DG1 only. During operation, times are recorded as
leading opaque edges of a "picket fence", bar tape, or a pulley spoke
pass through the photogate beam. These times are displayed in a data
table. More importantly, if you enter the distance between the leading
edges of the opaque bands in the Length of Object field, the program
can analyze the times, and calculate velocities, displacements, and
accelerations.

 
 
 When a picket fence or bar tape is used, the width of each of the bands
(d in the figure above) should be at least 0.5 cm. The distance between
the leading edges should be at least 3 cm or larger if the picket fence is
to be moving rapidly (for example in a free fall experiment). A closer
spacing can be used if the object will be moving slowly; for example,
on an air track glider.

 This mode uses one photogate connected to DG1. The timing will begin
when this photogate is first blocked. The timing will continue until the
photogate is unblocked. The duration of the interruption is thus timed.
If the length of the object is entered in the Length of Object field, the
velocity is calculated.

 Gate Timing with Two Gates works with photogates connected to DG1
and DG2. It is assumed that the photogates will be interrupted in
sequential order. The time measured at each photogate is reported in a

 Collect photogate data

 Motion Timing

 Gate Timing - One Gate

 Gate Timing - Two Gates
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different column in the data table. If the length of the object is entered
in the Length of Object field, the velocities are calculated.

 Pulse Timing refers to the measurement of the time from the blocking of
one photogate until another photogate is blocked. The timing will begin
when the photogate in DG1 is first interrupted. It will continue until the
photogate in DG2 is interrupted. If the length of the object is entered in
the Length of Object field, the velocity is calculated.

 The Collision Timing mode uses photogates attached to DG1 and DG2.
It differs from other timing modes in a number of ways. It allows both
photogates to time independently and times are listed in the data table in
columns, according to the gate at which they were measured. Other
modes list times in columns, in order as they were measured. A data
table of results measured in this mode will look like this:

 
 Times Listed By Gate:
 Delta T1      Delta T2
   (s)          (s)
 0.5552 0.7872
 0.4332
 3.4437
 1.0012 1.2623
 
 For each gate, the times are listed in the order in which they were
measured. In the example above, photogate #1 was blocked 4 times and
photogate #2 was blocked twice.

 Notice that the Collision Timing mode is similar to the Gate Timing -
Two Gates mode, without any restriction on the order in which the two
gates are blocked. This mode is specifically designed for studying air
track collisions. It allows the study of virtually any possible collision.

 The Pendulum Timing mode uses a photogate attached to DG1. The
timing will begin when the photogate is first interrupted. The timing
will continue until the photogate is interrupted twice more, so that you
get the time for a complete swing of a pendulum or other oscillating
object.

 This mode requires two photogates. The first timing is of the duration
of the interruption of the photogate #1. The second timing begins when
photogate #1 is unblocked. This timing continues until photogate #2 is
blocked. The third timing is of the duration of the interruption of the
beam in photogate #2. If the length of the object is entered in the Length
of Object field, the velocity is calculated. The acceleration is calculated
from the change in speed.

 Pulse Timing

 Collision Timing

 Pendulum Timing

 Gate and Pulse Timing
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 The following diagram illustrates the various photogate timing modes.
For each line, the vertical axis represents the photogate state with
unblocked as high, and the horizontal axis represents time.

 

 To collect data from the Radiation Monitor or the Student Radiation
Monitor, choose Data Collection from the Setup menu. It is not
necessary to set any inputs using the Setup Sensor dialog. Choose
Radiation Counting from the drop down menu on the Mode tab. Click
the Sampling tab to set the experiment length and the length of one
counting interval. Logger Pro will report the number of pulses received
during each counting interval.

 There are two Radiation Counting methods: Real Time Collect and
Events with Entry, chosen on the Sampling Tab. In Real Time Collect
mode Logger Pro will count for successive counting intervals until the
set experiment length is reached. In Events with Entry, Logger Pro will
count for successive counting intervals, but will not record a value until
the Keep button is pressed. At that time an entry field will be displayed
for the user to enter a value. Press Enter to complete the entry, and then
Stop when the desired number of points have been collected.

 Collect radiation data
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 You can correct mistakes in the prompted column created by Events
with Entry mode. First, collect any additional data required in the run.
Then, click the Stop button. In the Data Table Window, click on the cell
you want to change. Type the new value. Click on another window to
confirm your entry, or press Enter to continue corrections in the cell
below. Sensor data cannot be modified, just as a scientist never erases
data in a notebook.

 If the column used for the
horizontal axis is not in
ascending or descending order
the graph will not be drawn
correctly when connecting lines
are enabled. This can easily
happen when the column
consists of prompted entries.
Choose Sort Data from the Data
menu, choose the column by
which to sort, click ascending or
descending as desired, and click
OK.

 Correct entries

 Sort data
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 View Other Window Types

 The Windows menu contains commands that add or replace windows to
the Logger Pro Screen. Since each new window reduces the screen area
available for the existing windows, the precise action of the window
commands depends on the currently active window. New Tall Window
halves the width of the current window and creates a new window of
vertical orientation of the selected type. Similarly, New Window Wide
halves the height of the current window and creates a wide window of
the selected type. Replace Window replaces the selected window with a
window of the newly selected type.

 

 Choose New Tall Window � Graph from the Window menu. A new
graph window will be created. Note that it may be more useful to create
a new pane in a graph window instead since less screen area is required.
See Graph Layout in the View menu of Logger Pro Reference for more
information.

 Choose New Tall Window � Table from the Window menu. A new
data table window will be created.

 Choose New Tall Window � FFT � FFT Graph to create a new graph
window holding the FFT (Fast Fourier Transform) of the current data.
Once you have created an FFT Graph, you may choose FFT Table to
open a new data table window containing the numerical FFT
information. Double click on either FFT window type to adjust its
properties.

 Choose New Tall Window � Histogram � Histogram Graph to create
a new histogram window representing the current data. Once you have
created a Histogram Graph, you may choose Histogram Table to open a
new data table window containing the numerical histogram data.
Double click on either histogram window type to adjust its properties.
The bin width may be changed in the Axis Options tab of the Histogram
Options dialog box.

 Choose New Tall Window � Text from the Window menu. A new
window will be created for text entry. You can use this window for
laboratory instructions, information about the experiment, or other
notes.

 Graph

 Table

 FFT �� FFT Graph
FFT Table

 Histogram �� Histogram
Graph
Histogram
Table

 Text
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 Choose New Tall Window � Meter from the Window menu. A dialog
box will open which allows you to select the data columns to be
displayed in a digital meter window. Then a new window will be
created containing the selected digital readouts. Double-click on the
meter window to change which quantities are displayed.

 

 This feature is not available in the current version of Logger Pro.

 After opening several different windows, the screen can get cluttered.
To help organize your screen, choose Autotile from the Window menu.
Autotile will fill the screen area with the open windows, making them
as large as possible but keeping all in view at once.

 Meter

 Chart recorder

 Arrange graph and data
windows
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 Analyze Data

 Choose Examine from the Analyze menu. A legend will appear,
accompanied by the numerical value at the mouse pointer position. As
the mouse cursor is moved across the graph, the legend readout will
change and the data table will scroll to highlight the associated time and
numerical values.

 If you have a meter window open and Live Readouts mode is not
enabled, then the meters will also read values near the cursor location.

 To draw tangent lines and read the slope of those lines, choose
Tangent from the Analyze menu (or click on the tangent line
button on the toolbar) and move the pointer to the place where
you want the slope. A legend will appear, accompanied by the
numerical value of the data and the slope of the tangent line at the
pointer position.

 Often you will want to compare two similar runs of collected data.
When you get the first useful run, choose Store Latest Run from the
Data menu. Now you may take additional data and the stored run will
not be lost. The data will be retained through subsequent data
collections, and can be displayed or hidden as desired. Stored runs are
numbered sequentially. Any number of runs can be stored, and will be
saved when you save an experiment to disk.

 The Data menu has two more relevant functions. Hide Run will
temporarily remove the selected run from the graph, and Show Run will
put it back. Using these functions you can superimpose any desired set
of runs.

 To fit a straight line to your data, select the desired portion of the
data by dragging across it. Next, choose Linear Fit from the
Analyze menu (or click on the linear regression button on the
toolbar). A straight line will be fit to the indicated data, and the slope
and intercept information will be displayed in a floating box. Displayed
precision can be adjust by double-clicking on the floating box to open a
new dialog box.

 To fit more complex functions to your data choose Curve Fit
from the Analyze menu (or click on the general fit button on the
toolbar). You will see the following dialog box. To fit to just a part of
your data, you must first select the desired portion of the data by
dragging across it.

 Read values from graph

 Display tangent lines
 

 Compare runs

 Fit a line to data
(linear regression)  

 Fit functions to data
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 Now choose a mathematical relation from the list at the lower left. You
may need to scroll through the list to find the appropriate function. The
polynomial choice also requires that you set the degree of the
polynomial. Next, choose the data set you want to use from the Perform
Fit On menu. Click on Try Fit to see the result. If you like, choose
another function or data column for another trial fit. You can also select
a different range of data by dragging across the graph region. Click on
Try Fit to see the new fit. Once you have a fit that you like, click on OK
to display the fitted curve on your graph. Click on Cancel to discard all
fits. The Apply button will place the fitted curve on the main graph
window without closing the dialog box.

 To superimpose a function over your data, make a graph active by
clicking on it once. Select Manual Fit from the Analyze menu. In the
dialog box select a function. Adjust parameters as needed to fit the
function to your data.

 Note that poorly-chosen parameters may make the function miss the
graphed region entirely. In this case it is difficult to adjust the
parameters by trial and error. You may want to select parameters
carefully so that the function matches the data at the y-intercept, and
adjust values from there.

 You can adjust either the number of significant digits or the number of
decimal places used in displaying fit statistics and parameters. After
you have completed a fit, double-click on the floating box containing
the fit information. A floating box options dialog will open, allowing
you to set the line color, line style, fit coefficients displayed, and their
precision.

Model Data
(Manual Fit)

Change Displayed Precision
of Fit Parameters
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 To interpolate between data points, first fit a function to a range of data.
Then choose Interpolate from the Analyze menu. The floating box for
the curve fit will expand to show the coordinates of points along the
fitted curve. Move the mouse pointer to the place you want to
interpolate.

 To perform an FFT on the entire data sequence, choose New Tall
Window � FFT � FFT Graph from the Window menu. You can also
use New Wide Window. Double click on the FFT window to adjust its
parameters.

 Interpolate points

 Perform an FFT
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 Perform Data Table Functions

 

 You can control what is displayed in the Data Table Window. The
display font can also be changed if you want to see a larger or smaller
number of rows at once. Double click on the data table to change table
options and click on the Table Layout tab. You will see this tabbed
dialog box.

 

 Choose the table layout you need. The choices allow you to display all
columns from all runs, just a single run, or just one column from all
runs. You can further control what is shown in the data table by hiding
individual columns in the Column Options dialog found in the Data
menu, or by double-clicking a column header.

 The Font Options tab shows a dialog in which you can choose display
font and size for the data table.

 Double clicking a column heading or the Run heading will open the
Column Options dialog, allowing you to change the column name,
width, color, or digits displayed. Double clicking the Run header will
allow you to choose a column from a list; double clicking a column
header directly will take you to the Column Options dialog for that
column.

 Change what runs appear in
the data table

 Change a column’s name,
color, width, or digits
displayed
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 In the Column Options dialog you can change the column’s name, color,
decimal places displayed, and width. If you click in the box for
Propagate Changes, all runs for that column will be affected. Hide
Columns will conceal the column in the data table.

 As Logger Pro gathers data from a sensor, the data table fills in with
time and sensor readings. You can define rules for columns calculated
from the sensor readings much like you enter formulas in a spreadsheet.
The definition can be entered either before or after the data are
collected. These new columns can be graphed just like any other
column, even as data are being collected. The calculated columns can
be used for a variety of purposes, including graphing calculated data or
data entered from the keyboard. These are described in turn below.

 As an example, let us convert temperatures measured in degrees Celsius
to degrees Fahrenheit. To get °F, we will need to multiply the raw data
from the Temperature Sensor, in °C by 9/5 and then add 32.

 First, choose New Column from the Data menu. You will see this dialog
box, but without the entries you are about to make. Click on the Options
tab to be sure this pane is on top.

 Calculate new values from
raw data (new columns)

 Calculated data columns—an
example
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 Labels

 To give this example column appropriate labels, enter Fahrenheit in the
label field and degrees F in the units field. The short label is used in
places where there isn’t room for the whole name; here, F would be a
good choice.

 While here you can also make other choices for the new column such as
color for graphing.

 Next click on the Definition tab to see the rest of the dialog box and to
complete the column creation process.
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 Equation

 The Equation field is where you will build the formula that defines the
new column. In this example of finding °F, we need to enter in the
formula field 9/5*“Temperature”+32. (Because of the order of
arithmetic operators, no parenthesis are needed, but you can use
parenthesis as desired to make the formula more readable.) To avoid
typographical errors, choose variable and function names from the
Variable and Function lists rather than typing them in.

 Graph Column On

 The newly calculated column can be graphed either on the y- or the x-
axis. In this case the default of the y-axis is appropriate. The new
column will replace whatever had been graphed on its column.

 Try New Column

 When you click on the Try New Column button, the calculation will be
performed and plotted if some data have already been taken. If you like
what you see, click on OK to return to the main graph window which
will include the calculated plot.

 To enter a data column manually, choose New Column � Manual from
the Data menu. Enter a label, short label, and units in the fields
provided. Choose a color and point protector as desired.

 The data table will contain a new, blank column. Click on a cell to type
in values.

 To paste a column of numbers from the clipboard into a Manual Entry
column, click the first cell, then choose Paste from the Edit menu.

 You must have already collected data from a sensor to enter data
manually. The maximum number of manually-entered points is limited
to the number of points already collected from a sensor.

 To copy all or part of your data in numerical form, select the desired
portion of the data table; you can select it all by choosing Select All
from the Edit menu. Next, choose Copy from the Edit menu to place the
data on the clipboard. Now switch to the destination application.

 Once you have the receiving spreadsheet ready to accept the data,
choose Paste from the Edit menu. The data will appear in the
application. You do not have to quit Logger Pro to switch to another
application.

 Enter data manually

 Copy data to a spreadsheet
or graphing program
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 Save and Print Data

 You can save your experiment to disk by choosing Save from the File
menu. The experimental configuration, including data, calibrations,
column definitions and window types will be saved. A standard save
file dialog box will appear. Choose a location for the file, enter a
descriptive file name, and click on OK.

 Saving a complete configuration in this manner is an excellent way to
record an experiment so you can later reproduce or extend the work in
identical conditions. In addition instructors can save a configuration for
students to use later; students then do not have to perform any
configuration or calibration and can immediately begin to collect data.

 To save only the calibration information so that it is available when
manually configuring Logger Pro, open the Sensor Setup dialog box.
Then click on the input corresponding to the desired calibration and
click on the Save button. Enter a name for the calibration file of eight
characters or fewer, and click on OK. The file will be saved to the
default calibration folder set in Logger Pro Preferences.

 Select the data and choose Copy from the Edit menu to place the data
on the clipboard. Paste the data into the receiving application, or to a
text editor to create a text format data file.

 Choose Open from the File menu, and navigate to the folder containing
the desired file. Click on the file name. Since experiment configuration
is stored in a Logger Pro file, on loading the file any current
configuration will be overwritten.

 To print a graph or data table, make the graph or data table the active
window by clicking on it, choose Print from the File menu, and respond
to the resulting dialog box.

 The default location of calibration and experiment files can be set in
Logger Pro preferences. While experiment files may be stored
anywhere, Logger Pro will first look in the default experiment file
folder. Calibration files, both those saved by users and those supplied
with Logger Pro, must be within the default calibration folder.

 To set default file locations, choose Preferences from the File menu.
You will see this dialog box.

 

 Save data, calibration and
configuration

 Paste data into other
applications

 Retrieve an experiment

 Print a graph or data table

 Set default file locations
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 Click on the appropriate Modify button to change either the default
calibration or experiment file folder. Choose the desired folder in the
subsequent dialog, and click OK.
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 Teacher’s Guide

 Software Installation

 To use Logger Pro, you must have the following equipment:

 A computer:

• A PC running Windows 95/98, Windows NT 4.0 or Windows
3.1x with at least 16MB RAM, at least a 486 processor, and an
unused serial port with a 16550 UART chip. If the computer’s
mouse is connected to a serial port, this means the computer
will need two serial ports. (Please contact us for further details.)

 or:

• A Power Macintosh or Power PC running System 7.6.1 or
newer with at least 16MB RAM, 10 MB of hard disk space,
and an unused modem or printer port. Macintosh computers
lacking a serial port will require a USB-to-serial adapter.

 An interface, which can be either:

• A Universal Lab Interface (ULI) with a 9-volt power supply and
an interface cable

 or:

• A Serial Box Interface with a 9-volt power supply and an
interface cable

 and at least one sensor:

• A temperature sensor or a Motion Detector are good choices for
initial testing of Logger Pro. A Voltage Probe is included with
the ULI and Serial Box Interface and can also be used.

 All of these items (except computers) are available from Vernier
Software, 8565 S.W. Beaverton-Hillsdale Hwy., Portland, Oregon
97225-2429, (503) 297-5317, email: info@vernier.com, web site:
www.vernier.com.

 Appendix C discusses the differences between the ULI and the Serial
Box Interface, and Appendix D lists sensors compatible with Logger
Pro.

 Before turning on your computer, you should set up the Universal Lab
Interface (ULI) or Serial Box Interface with a sensor. The interface
should be placed near the computer. First connect the interface cable to
the interface. Then attach the cable to any unused serial port4.

                                                     
 4On the PC, the connector on the computer may be either a 25-pin plug or a
smaller 9 pin connector. An adapter is supplied with the interface to make the
appropriate connection to your computer.

 Required materials

 Initial setup
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to

to Serial I/Ointerface

to serial port

to 115VAC
power adapter

 Interface Connections

 Next, plug the 9-volt power supply into the matching receptacle on the
interface and into a source of 60-Hz, 115-VAC power.

 To install Logger Pro on a Power Macintosh, follow these steps:

• Place the Logger Pro CD in the CD-ROM drive of your computer.

• Double-click the icon Install Logger Pro and follow the instructions
on screen.

 To install Logger Pro on a computer running Windows 95/98/NT 4.0,
follow these steps:

• Place the Logger Pro CD in the CD-ROM drive of your computer.

• If you have Autorun enabled, the installation will launch
automatically, otherwise choose Settings � Control Panel from the
Start menu. Double click on Add/Remove Programs. Click on the
Install button in the resulting dialog box.

• The Logger Pro installer will launch, and a series of dialog boxes will
step you through the installation of the Logger Pro software. You will
be given the opportunity to either accept the default directory or enter
a different directory.

 To install Logger Pro on a computer running Windows 3.1x, follow
these steps:

• Place the Logger Pro CD in the CD-ROM drive of your computer.

• From the Program Manager choose Run from the File menu. In the
Command Line Field type d:\setup or e:\setup depending on the CD-
ROM drive used in your computer, and click OK.

• The Logger Pro installer will launch, and a series of dialog boxes will
step you through the installation of the Logger Pro software. You will
be given the opportunity to either accept the default directory or enter
a different directory.

• In order to run Logger Pro on a Windows 3.1 machine, Microsoft
WIN32s software must be installed. If WIN32s is not installed on your
machine, you will be prompted with the following screen:

 Software installation
Macintosh

 Software installation
Windows 95/98/NT 4.0

Software installation
Windows® 3.1x
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• Make sure that the path is pointed to “disk1” on the Logger Pro CD.

 
• Click OK and follow the remaining directions.

Note: If your computer does not have a CD-ROM drive, please contact Vernier
Software to request a copy of Logger Pro on floppy disk
 

 If your computers are served software from a central file server on a
network, you can install Logger Pro on the server.

 Additional suggestions for configuring a network server to work with
Logger Pro can be found in Appendix B.

 Software installation
(network)
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 Ideas for using Logger Pro in the classroom

 The tutorials, printed separately from this manual but included with
Logger Pro, can also be used as a student introduction to the program.
The first two, Temperature and Motion, are parallel introductions to
Logger Pro. The former is designed for all students, and the latter for
students who will use the Motion Detector. The remaining tutorials
extend the two introductory tutorials to more advanced use, including
data analysis and curve fitting. They might be used as individual class
assignments or could be made available for reference as students begin
using Logger Pro.

 Experiment files contain information about the particular configuration
of Logger Pro, including the number of graphs, what is plotted on each
axis, the data collection rate and mode, what sensors are connected to
inputs, and the calibration information used. In other words, a complete
data collection environment can be saved for later use. If a custom
calibration is performed, that information is saved in the experiment file
without requiring a separate calibration file. Once an appropriate
experiment file is loaded and the interface and sensors connected, you
are ready to collect data.

 Many teachers find that they spend less time teaching computing and
more time teaching science if they make use of experiment files. Some
curricular packages include experiment files for Logger Pro, so that
students can load an indicated file and be ready to take data in a mode
appropriate for the experiment. You can also create your own
experiment files for use with custom laboratory experiments. See the
section below on creating your own experiment files.

 Logger Pro comes with an extensive set of experiment files. The first
set is designed for typical experiments done with each Vernier sensor.
These files are in folders corresponding to the sensor name. The next
set, found in the Tutorials folder, are for the tutorials earlier in this
manual. The remaining six sets are keyed to the specific experiments
found in the Vernier publications of ready-to-use classroom
experiments.

 When experiment files are installed on individual computers, it is
important to keep the files from being unintentionally altered. The
open-file dialog box includes a check-box marked Open as Read Only.
When the check-box is marked (the default), a file is opened as read-
only. A read-only file can be used normally, but it cannot be saved using
the Save command. The save button on the toolbar and the Save
command are disabled, and if the user clicks Save As…, the file name
field is blank. The file can be saved under any name, but if the name
matches an existing file an extra confirmation dialog will be presented.

 If you intend to make permanent changes to an experiment file, clear the
check-box, open the file, and make the desired changes. Save your file.

• Biology with Computers, by David Masterman, and Scott Holman 30
experiments.

• Chemistry with Computers, by Dan D. Holmquist and Donald L. Volz,
30 experiments.

• Physical Science with Computers, by Donald L. Volz and Sandy
Sapatka, 41 experiments.

• Physics with Computers, by Kenneth Appel, John Gastineau, Clarence
Bakken, David Vernier, 34 experiments.

 How to use the tutorials

 Experiment files are
important!

 Experiment files included
with Logger Pro

Protecting experiment files

 Sources of experiments for
Logger Pro
from Vernier Software
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• RealTime Physics, by David Sokoloff, Ronald Thornton and Priscilla
Laws, 12 experiments in mechanics. (RTP folder)

• Tools for Scientific Thinking, by Ronald Thornton and David Sokoloff.
Experiments in Motion and Force; Heat and Temperature, Sound.
(TST folder)

 The experiment files for these books are found in the Experiments
folder of Logger Pro with names beginning with an underscore to move
them to the head of the file list:

 

 Although creating an experiment file will save calibration information,
you can also save sensor calibration information separately. Your
custom calibration will then be among those offered in the sensor setup
dialog.

 Logger Pro includes calibration files for the Vernier Software sensors
listed in Appendix C. For most sensors these calibrations are all you will
need. A few sensors, such as for dissolved oxygen and colorimetry need
individual calibration; the force and pH sensors can be calibrated for
higher-accuracy results. The calibration procedure is described in the
reference section.

 To create your own experiment files, you will need to set up Logger Pro
as appropriate for your experiment. You may want to start with an
existing experiment file that is close to the configuration you need.

� Configure or confirm that Logger Pro is properly set for the sensors
you will use, including any calibration information.

� Set the data collection mode, period, and rate as needed.

� Define any new columns you need.

� Set up the graphs as desired. Create the number of graphs, the
scaling, and what is plotted for your experiment.

� Consider entering an Experiment Note (choose About filename from
the Help menu, where filename is the experiment file name) to give
preliminary instructions which will be displayed when the file is first
opened.

� Consider adding an explanatory or instructional text window which
will be visible during data collection. (Choose New Window �
Text)

Calibration files

Creating an experiment file
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� Test your setup by performing a trial experiment, and make changes
as needed.

� If you do not want to save your example data with the experiment
setup, clear the data by choosing Clear All Data from the Data menu.

� Choose Save from the File menu. Enter a descriptive file name, and
save the file.

 To use the file later with students, place a copy of the file in the default
experiment file directory specified in the Logger Pro preferences file.

 Certain settings of Logger Pro, such as the default location of files and
the statistics presented in curve fits, which you are unlikely to change
every session, can be stored in a preferences file. See Preferences under
the File menu. The file must be stored in the same directory as Logger
Pro. If you are using a network, be sure you have sufficient privileges
when you store your preferences. Consult Appendix B for detailed
network suggestions.

 Using Logger Pro on a network is similar to using it on a stand-alone
computer. However, the benefits of network access to Logger Pro
include the need to install only one copy of the software, further
protection of experiment and calibration files from accidental change,
and reduced hard disk requirements on the local computers. For details,
see the discussion in Appendix A.

 During the installation process above, a directory will be placed on your
hard disk which includes Vernier calibration files and experiment files.
The preferences file will initially use these directories as default.

 Appendix C lists the sensors compatible with Logger Pro.
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Keystroke Equivalents

 Logger Pro supports standard keystroke equivalents for common menu
commands. On PC hold down the Control key (it may be labeled Ctrl on
your keyboard) and the appropriate letter key. On Macintosh computers
hold down the Command key while striking the appropriate letter key.

 command  keystroke

 Save  Control/Command S

 Open  Control/Command O

 Print  Control/Command P

 Autoscale  Control/Command A

 Undo  Control/Command Z

 Copy Graph  Control/Command G

 Copy  Control/Command C

 Cut  Control/Command X

Customizing Logger Pro

Using Logger Pro on a
network

Using Logger Pro on
stand-alone computers

Sensors to use with
Logger Pro
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 Paste  Control/Command V

 Replay  Control/Command R

 Adjust Sampling  Control/Command M

 Adjust Averaging  Control/Command E

 Adjust Triggering  Control/Command T

 

Toolbar

 The toolbar provides quick access to some common functions. From left
to right, these are Open, Save, and Print. The next group includes
Autoscale, Zoom In, Zoom Out, and Undo Zoom. The third group
toggles Analyze, Tangent, Statistics, Integral, Line Fit, and Curve Fit.
Next, the stopwatch button opens the data collection dialog box. The
icon showing an interface selects the Sensor Setup dialog, and the
Collect button initiates data collection. If present, the Zero button resets
an analog sensor reading to zero.

 You can quickly see what a tool does by positioning the pointer over the
button for a moment; a legend will appear.

 

Cursor Controls

 You can change the graph appearance and behavior through a number of
“hot spots” on the Graph Window and the Table Window. The screen
below shows some of these functions.

 These areas of the Graph Window are active to cursor control:
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 Click on the graph title to obtain a dialog box in which you can modify
or remove the graph title.

 You can click on the minimum or maximum axis numeric labels and
type in a new value. The axis of the graph will change accordingly.
When the independent variable is time the right-most time value will
also determine how long data are collected.

 Clicking an axis label will open a dialog box that allows you to choose
what is plotted on that axis.

 You can scroll the viewing region of the graph with the scroll arrows.
The axis limits will change, but the interval displayed by each axis will
remain the same.

 To change the scale of one axis at a time, click on it. A dialog box will
open, allowing you to control the scaling of that axis.

 Double-click on a graph to change several properties at once. The
Graph Options dialog will appear, allowing you to change scaling,
labels, or plot style. More details can be found under Graph Options in
the Logger Pro Menus section.

 If there is more than one graph on the screen, any commands that affect
graphs will change only the selected graph. To select a graph, click on
it. A border will appear around the graph to indicate that it is selected.

 The Table Window also responds to clicks:

 Clicking the All/None button will alternately select all data and no data.

 Double-clicking the row numbers will open the Table Options dialog.
There you can change the font used and choose which columns will be
displayed.

 Double clicking the Run Heading (Latest, Run 1, and so forth) will
open a dialog box holding a list of columns. Select a column, click on
OK, and the Column Options dialog for the chosen column will open.
Double-clicking a specific column header will open its Column Options
dialog directly. You can find more details about Column Options under
the Data menu details below.

Graph title

Tick mark labels

Axis labels

Scroll arrows

Axes

Graph options

Selecting a graph

Select All/None

Column properties

Column options
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 To rearrange the order of displayed columns, drag the column header to
the desired position.

 Only cells in manually entered columns or prompted columns collected
in Events with Entry mode can be edited. Click the cell to be changed.
Type in the new value, and press enter.

 

Column order

Edit cell contents
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Logger Pro Menus

 (Macintosh only)

 Choose this item to display information about Logger Pro. The version
number and copyright notice are displayed.

 Choose New to open a new, blank graph window and data table. All
prior data, configuration, and calibration information will be lost.

 Choose Open to open a previously stored experiment file. In addition to
standard open-file dialog features, there is a check-box which when
filled will cause files to be opened as read-only. A read-only file can be
used for data collection, but if the user clicks or chooses Save an error
message will be displayed, protecting the original file. A read-only file
can be saved under a new file name using Save As…. The default is to
open files as read-only.

 Close closes the current experiment without quitting Logger Pro.

 Save will record the current experiment to disk. If the experiment has
not been saved before, Save is equivalent to Save As. If the experiment
has been previously saved, the experiment file is updated.

 This will save the current experiment setup with any data in the data
table. Opening this file later will restore Logger Pro to its current setup.

 Use this feature to import data saved with the Export Data option also
found in the File menu. These data exist in a tab-delimited text format,
and are imported into the Latest data run. Each file has a specific
structure that includes a time stamp, data column names, short names,
units, and data. If you make changes to the exported file, be sure to
preserve the original structure. After choosing this option, select the
appropriate file. If you plan to collect data after importing, you may
need to configure the sensors before importing data. (See How To
Configure Sensor Functions in this manual.)

 This option exports data to a tab-delimited text file. Only raw data
including time and manually-entered data from the Latest data run are
exported to the file. Calculated columns or curve fit columns are not
saved. A time stamp, column names, short names, and units are saved to
the beginning of the file. After choosing this option, enter the name of

Apple menu

About Logger Pro…

File menu

New

Open

Close

Save

Save As…

Import Data

Export Data
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the file you wish to create. Note: Do not confuse this option with the
Save or Save As options which save all the details of the current
experiment. Use the Export Data option only if you want to create a file
that can be read by other applications such as spreadsheets or word
processors. You can instead use copy and paste features to transfer data
to other applications.

 Page Setup calls a dialog box in
which you can set text that will
be printed with any graph or data
table. This helps to identify
printouts coming from a shared
printer. If the Date field is
checked, the date and time of
printing are included on the page.
If the Always Show Page Setup
field is checked, this dialog box
will be displayed whenever the
print command is issued. In that
case, clicking OK will then
display the Print dialog box where the number of copies is set.

 Printer Setup

 Print Setup will display the current printer’s setup dialog. Options such
as print quality and paper source can be chosen here.

 Choose Print to print either a graph or data table window, whichever
window type is active. If the active window is a graph window with
more than one pane, you will given a choice of printing one pane or all
panes. The available options will depend on the type of printer
available.

 Print Preview will show a reduced-size image of the page as it will be
printed. This is useful to ensure that a given print request won’t take too
many pages.

 There are two classes of Logger Pro settings under user control: default
file locations, and a display option.

 The default locations of calibration information and experiment files
can be set using the Folder Locations tab.

 Logger Pro will only detect calibration files stored in the default
calibration folder. New calibration files are saved to this folder as well,

Page Setup

Print

Print Preview

Preferences
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and will subsequently be available in the list of calibrations in the
Sensor Setup dialog box.

 In contrast experiment files may be stored anywhere, but Logger Pro
will first look in the default location set here.

 To set either folder location click the appropriate Modify button and
navigate to the desired folder, or just type in the full path to the desired
folder.

 The Window Controls tab allows you to set the Over Range Autoscale
functions. During data acquisition the data may exceed the existing
range settings of the graph. If this box is checked, Logger Pro will
automatically autoscale the graph during data acquisition to include all
data acquired so far.

 Choosing Quit or Exit causes Logger Pro to prompt you to save any
unsaved data, then exits the program.

 The Undo command will reverse the effect of the most recent operation
(if possible). For example, after data collection, the Undo command
becomes Undo Collect. This is valuable if the previous run is needed
but had not been stored.

 Cut removes the selected data and places it on the clipboard. Not all
data may be removed. Measurements made by Logger Pro directly (the
raw data) are locked and cannot be deleted. New columns that you
create are unlocked and can be edited or cleared.

 The locking of raw data columns is an intentional feature of Logger
Pro. Since the raw data are simply a record of what is measured by the
sensor, it is inappropriate to change them, much as a scientist never
erases data from a notebook.

Quit (Macintosh) or Exit (PC)

Edit menu

Undo

Cut
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 When a graph window is the active window, Copy Graph will place a
copy of the graph on the clipboard. You can then paste the graph into a
word processor or other application.

 Copy places a copy of the selected data on the clipboard.

 Paste places a copy of the clipboard contents at the cursor location.
Pasting is possible in the text window and into Manual Entry data
columns.

 Clear removes the selected data without putting them on the clipboard.
Locked data such as original data may not be removed. Only manually
entered data may be cleared.

 Select All is used to select the entire data table for subsequent copying.

 Collect begins a data collection run. Clicking the Collect button in the
toolbar has the same effect.

 After data are collected, choose this item to get an instant replay of the
data collection. Select the run you wish to replay from the drop-down
menu. You can set the replay rate to faster than real time, slower, or to
the original rate.

 Stop causes data collection or replay to cease.

Copy Graph

Copy

Paste

Clear

Select All

Experiment menu

Collect

Replay

Stop
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 Sampling opens the Sampling tab of the Setup Data Collection dialog
box. For additional information see the discussion under Setup menu.

 Averaging opens the Averaging tab of the Setup Data Collection dialog
box. For additional information see the discussion under Setup menu.

 Averaging opens the Triggering tab of the Setup Data Collection dialog
box. For additional information see the discussion under Setup menu.

 This is a toggled mode. Choose Live Readouts to turn the mode on;
choose it again to turn off. When the Live Readouts mode is on, the
current sensor readings will be displayed in any meter window. When
Live Readouts is disabled, the meter window reports the sensor value
on the graph nearest the cursor position. The current sensor readings are
always displayed in the status bar.

 Logger Pro uses a range of points to calculate derivatives, tangent line
slopes, and smoothed data. You can set the number of points used for
these functions. The first setting affects the derivative( ) function used
in column definitions as well as the drawing of tangent lines. The
second setting affects only the smooth( ) function used in column
definitions.

 In either case, a smaller number of points will make the functions more
responsive to small changes in the data, but larger numbers will reduce
noise.

 

 If the Display zero button item is checked, a Zero button will be placed
on the toolbar. The zero button will tare (zero) the reading of applicable
analog sensors such as the Force Probe.

 The Enable Automatic Curve Fit option is checked by default.
Unchecking it will disable the Curve Fit function from the Analyze
menu and the Toolbar. Users may wish to disable automatic curve fits to
force students to perform manual fits instead.

 The choice of angular units used in trigonometric calculations in Logger
Pro is selected by clicking either Radians or Degrees.

 All settings in the Options dialog are stored with an experiment file.

 Calibrate is a shortcut to the Calibrate tab of the Sensor Properties
dialog. The sensor setup discussion below give step-by-step instructions
for performing a calibration.

Sampling

Averaging

Triggering

Live Readouts

Options

Calibrate
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 Zero resets a sensor to zero without
otherwise changing its calibration. Zero
is primarily used with force sensors, but
can be used with any analog sensor, as
well as the Motion Detector and the
Rotary Motion Sensor. If two or more
sensors are active, the following dialog
box is presented, allowing you to choose
which sensor(s) are to be zeroed.

 

 

 

 

 

 

 To preserve a run in memory choose Store Latest Run. If you do not
store it, the next time the Collect button is clicked the latest run will be
deleted automatically. Stored runs are numbered sequentially as Run 1,
Run 2, and so forth. You can store as many runs as your computer’s
memory allows.

 Show Run is a hierarchical menu which allows you to select which runs
will be shown on the graphs and data tables. The number of choices
depends on how many runs you have stored.

 Hide Run is also a hierarchical menu. It allows you to keep a run from
being plotted or shown in the data table. You can choose between the
latest run and any stored runs.

 Delete Run allows you to remove any stored run from memory, as well
as the latest run.

Zero

Data menu

Store Latest Run

Show Run ��

Hide Run ��

Delete Run ��



Logger Pro Reference

56 Logger Pro

 Choosing a run from the
hierarchical menu of About Run
shows the time the data were
collected. A text area allows you to
enter notes about a run. This
information is only available by
again choosing About Run.

 

 

 Sort Data will arrange rows in
the data table according to
values of the selected column.
This function is useful if data
were gathered in another order,
and now you want to integrate
or plot the data with connecting
lines.

 On selecting Sort, you will see
a dialog in which you can
choose the column which will
determine the sort order, and
whether the sort is ascending or
descending.

 Once you have sorted a data
column, the sort will be performed on all subsequent runs as the data
are collected.

 This command allows you to define a new column of data that will
appear in the data table and optionally on the graph. The new column
may be either a column calculated from other columns using a formula,
or it may be manually entered. For both types of new columns a tabbed
dialog box appears. The new column must be named and may be given
units.

 After setting the new column name and units, formula-based new
columns require a defining formula. The definition tab allows you to

About Run ��

Sort Data

New Column

New Column �� Formula
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define new columns based on other columns using an equation. To
create new column based on an equation, enter the desired relationship
in the equation field. The contents of existing columns can be chosen
from the Variables menu, and common mathematical functions can be
chosen from the Function list. For more information see the tutorial on
creating new columns.

 The functions include several appropriate to columns of data:

 integral

 The integral function gives the running sum of the product of point
values and the increment of the independent variable, which is usually
time. That is, it delivers the numerical integral of the data column.

 derivative

 The derivative function gives the slope of the indicated function with
respect to the column plotted on the horizontal axis. Only the dependent
variable (y axis) is specified in the function. The independent variable
(x axis) is determined by the graph. For example, if the graph were pH
vs. Volume, derivative(“pH”) will be ∆pH/∆Vol. The number of points
used in determining the slope is controlled in the Logger Pro
preferences found under the File menu.

 smooth

 The smooth function reduces noise in the indicated column. The
number of points used for a moving average is controlled in the Logger
Pro preferences found under the File menu. There is no loss of data
points from smoothing.

 Graph Column On

 The calculated column can be graphed on either axis. The default
choice is the y axis. Click the x-axis label to plot the new column on the
horizontal axis.
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 Try New Column

 Clicking the Try New Column button will graph the new column in the
sample graph. You can make changes to the definition, and check out
the changes by clicking this button again. Click OK to keep the new
column and return to the main Logger Pro screen. Cancel will close the
dialog box and discard any entries.

 Manual columns only require a name. The new column will be created
in the data table. Select a cell by clicking it. Type in your values, ending
each entry with the return key. You can also paste a column of data after
clicking the first cell. Manual columns are limited to the number of data
points already collected using a sensor.

 Modify Column allows you to change the definition of a calculated
column. The same dialog box as for New Column above is displayed.

 Use Delete Column to remove unneeded columns.

 Column Options opens a dialog in which you can change the name of
the column, change the point style used, units, and displayed precision
of data. Use this option to modify existing columns.

 

 Clear All Data removes all data from the data table. You will be
prompted to save any unsaved data.

 

New Column �� Manual

Modify Column

Delete Column

Column Options

Clear All Data

Analyze menu
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 Examine is a toggled mode. When active, the mouse pointer becomes a
vertical line and the value of the data at the indicated time is displayed
in the graph legend.

 Tangent enables the drawing of a short tangent line at the cursor
location to each data column plotted. The numerical value is displayed
in a floating box. The number of points used to calculate the slope can
be set in under Preferences in the File menu.

 Make Annotation allows you to create a floating box with any text you
choose. This is useful for placing comments on graphs. To edit an
annotation, double click on the floating box. To remove an annotation,
click the close box on the upper right corner of the floating box.

 The interpolate function can only be used after a function has been fit to
experimental data. After choosing interpolate, the value of the fitted
function is displayed as a function of cursor position.

 Linear fit performs a linear least-squares fit on the selected data. If there
is no selection made the entire data run is used.

 The Curve Fit item gives you a choice of advanced curve fitting
options. These curve fits are automatic in the sense that the fit
parameters are determined by Logger Pro using least-squares methods.
The dialog box below is opened.

 The graph portion of this window gives you a preview of the fit and
allows the selection region to be modified. To perform a curve fit,
choose first the type of fit from the scrolling list at lower left. For the
case of the polynomial fit, enter the degree of the polynomial in the
Degree field. Next, choose the column to be approximated by the fitted
equation. Click on Try Fit to see the result. Modify your choices as
desired. You can modify your data selection by repeating a drag across a
portion of the data and clicking on Try Fit again. Once you like the fit,
Click on OK to place the fit on the main graph window, or Cancel to
discard the fit altogether.

 Clicking Create Column will place a new column in the data table
containing the value of the fitted equation at each time.

Examine

Tangent

Make Annotation

Interpolate

Linear Fit

Curve Fit
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 The Curve Fit Options tab holds a new dialog box.

 The Curve Fit Options tab allows you to determine which fit statistics
are displayed on the graph. The Equation’s Coefficients are the fitted
parameters. The Mean Square Error and its square root, the Root Mean
Square Error, measure how far away on average the fitted function is
from the data. The Root Mean Square Error is in the units of the data on
the y-axis.

 You can also specify the style and color of the line representing the fit.
The Sample Line region provides a preview of the line appearance.

 The Displayed Precision field allows you to set the number of displayed
digits in the curve fit floating boxes. Select one of Decimal Places (a
fixed number of places past the decimal point) or Significant Figures
(the number of digits displayed, plus any need to show magnitude).
Enter the desired numerical setting for either mode.

 For the linear fit only, the fit and its statistics are determined as follows.
We have N ordered pairs of xi and yi. The best fitting line y = ax + b is
then given by

( )a x y x x yi i i i i= − ∑∑∑∑1 2

∆

( )b N x y x yi i i i= − ∑∑∑1

∆

where ( )∆ = − ∑∑N x xi i
2 2

 Measures of the goodness of fit are many. Most common are the scatter
standard deviation, σs, the linear correlation coefficient r, and the
uncertainties of the parameters a and b, σa and σb. The scatter standard
deviation measures how far away, on average, the data points yi fall
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from the fitted line, measured along a vertical line.5 σs is also called the
root mean square error, and is defined as

( )σs i iN
y a bx= − − −∑1

2

2
.

 We use N - 2 weighting since two parameters have been determined in
the curve fit.

The remaining quantities are defined as
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 The first two quantities are interpreted as the variance of the fitted
parameters, and so can be used as 67% confidence level uncertainties of
the slope and intercept.

 The correlation coefficient, r, is commonly calculated by scientific
calculators, but is a difficult quantity to interpret. The correlation
coefficient is intended to measure the degree of correlation between the
x and y values. It is not directly a measure of goodness of fit. For no
correlation at all (random values), r is near zero. For perfect correlation
r is ±1. From r one can determine a probability that the x and y values
are correlated. In the natural sciences, however, there is usually the
assumption that the two are correlated, and so the r value is not very
useful. Far more useful to a student or scientist is the uncertainty of the
slope and intercept. These uncertainties answer the question “How well
did the data determine a slope (or intercept)?”.

 No provision has been given to weighted fits, since in computer-
acquired data all data points are generally equally reliable.

 More information on curve fitting and the interpretation of the fitted
parameters can be found in Data Reduction and Error Analysis for the
Physical Science, 2nd edition, Philip R. Bevington and D. Keith
Robinson, McGraw-Hill, Inc., 1992.

 The curve fit function can be disabled in the Options, found in the
Experiments menu.

 Logger Pro will superimpose a function (sometimes called a model)
over your data using the Manual Fit option. In contrast to the curve fit
discussed above, where the parameters in the fit equations are
determined automatically using a least-squares technique, the Manual
Fit allows you to adjust the parameters by hand.

 A manual fit is often appropriate for instructional purposes. By
adjusting parameters manually, students will learn how each affects the
fit. A manual fit will also allow you to adjust a curve to fit a data series
in the way you want, possibly ignoring certain stray points within the
series.

 To perform a manual fit, click once on a graph to make it active.
Optionally, select a region of the graph using the mouse. This selection
                                                     
5The least squares fitting method assumes that the uncertainties in the x values
are negligible compared to the uncertainties of y.

Manual Fit
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region is used only for calculating the mean square error of the fitted
function with respect to the data. If you do not plan on using the mean
square error value, then it is not necessary to select a region. Then,
select Manual Fit from the Analyze menu. A new dialog box will open.

 First, you must select or enter an equation. The faster method is to
select an equation from the General Equation menu. In the screen
shown above, the linear relation y = mx + b has been selected. You can
also enter your own relationship in the Equation field. The equation
must contain between one and five adjustable parameters (single upper-
or lower-case letters) and the horizontal axis variable is entered as x.

 The values of each parameter may be adjusted in the Parameters fields.
You can either type in a new value directly, or you may use the up and
down arrows to increase or decrease the values using the mouse. Click,
or click and hold, on the desired arrow.

 The ∆ button near each parameter allows you to set the adjustment
increment applied when the arrows are used. The ∆ button for the b
parameter has just been clicked in the screen above. If the Auto Delta
box is checked (default is unchecked) then the increment will be made
smaller when the parameter reaches a magnitude similar to the
increment.

 Using the manual fit can be very helpful in understanding fitted
functions, but it can also be frustrating. A random or poorly-chosen set
of parameter values may result in a function which does not cross the
graphed region at all. Blind adjustment of the parameters will not often
move the function into view. Once a part of the function is in view, it is
usually easy to adjust the parameters to get a good fit.

 If your graph starts at x = 0, one way to get the function into view at the
start is to adjust the y-intercept value to match that of your data. Then
you will see at least a portion of the function, allowing you to adjust
other parameters as needed.
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 Clicking Create Column will place a new column in the data table
containing the value of the fitted equation at each x-axis value.

 The Perform Fit On menu allows you to select the column used for
calculating the Mean Square Error value. The Mean Square Error
measures how far away the function is, on average, from the data.
Automatic curve fits seek to minimize this value.

 Integral performs a numerical integration on the selected data.
First drag across the desired region of your data to select. Then
choose Integral (or click on the Integral button on the toolbar). You will
have the opportunity to specify which data set you want to integrate.
The numerical result is shown on the graph, and the corresponding area
shaded.

 The Statistics item displays a dialog showing statistical measures
of the selected data: maximum, minimum, mean, standard
deviation, and the number of points used. You may optionally select a
region of the data first. The entire data set is used when no selection is
made. After you select Statistics (or click on the Statistics button on the
toolbar) you will have the opportunity to specify for which data set you
want statistics calculated. The statistics are presented in a floating box
on the graph screen.

The standard deviation is found using N-1 weighting, or

( )σ = − −∑1

1

2

N
x xi .

 The first item in the View menu changes depending on the active
window. For example, to see Data Table Options, click once on a data
table before pulling down the View menu. Options settings for Text,
FFT, and Meter windows are also available.

Integral

Statistics

View menu
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 Choosing this item is equivalent to double clicking the graph. The
Graph Features tab of the dialog box is shown first:

 Point Protector Every … Points

 If this item is selected, a marker will encircle one of every N points.
Marker color and shape can be chosen by Choosing Column Options
from the Data menu.

 Legend

 Selecting Legend causes a legend to appear on the graph. The Legend
identifies the plotted columns by color and line style. A Legend appears
automatically when in Examine mode.

 Connecting Line

 Enabling Connecting Line draws a straight line from one data point to
the next.

 Bar Graph

 If this option is selected Logger Pro will draw vertical bars from the
horizontal axis to each data point. The bar width in pixels can be set in
the width field.

 3D

 If this option is selected, Logger Pro will draw the vertical bars of a bar
graph with shadows, giving an illusion of depth.

Graph Options
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 Grid

 A gridline for every tick mark can be displayed if desired. The color and
weight of the lines are controlled using the two pop-up menus at the
bottom of the dialog box.

 The Graph Options dialog also has an Axis Options tab:

 Here you can control what is plotted on the two axes as well as the
scaling used. The settings here are duplicated in the axis scale and
selection dialogs obtained by double-clicking an axis or axis label. The
columns shown will depend on your specific configuration of Logger
Pro. Scaling choices will also be used in subsequently collected data.
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 FFT Options allows you to control the way the Fast Fourier transform is
calculated and the way the graph is drawn. The Graph Features tab
allows you to set the same features found on the Graph Options dialog,
describe just above.

 The FFT tab determines how the FFT is calculated:

 Choose Column(s) to Analyze:

 The columns available will depend on the columns currently in the data
table.

 Filtering

 A raw FFT often will have undesirable artifacts which can be reduced
by appropriate filtering.

 Windowing reduces the weighting given to the first and last 10% of the
data sequence. This reduces high frequency artifacts due to the abrupt
beginning and end of data.

 Turning on High Pass Filtering will ignore any constant or linearly
dependent component to the data.

 Smoothing will reduce noise in the final FFT by performing a running
average on the raw data before the FFT is calculated.

 Enabling Show Peak Frequency will display the highest amplitude
frequency.

 Scale

 Set the desired scale of the FFT frequency (horizontal) and amplitude
(vertical) axes.

 The Histogram Options dialog box controls the appearance of a
histogram. The Graph Features tab is a subset of the standard Graph
Features tab, while the Axis Options tab allows control of the histogram
bin width. The data to be displayed and the scaling of the x- and y-axes
is set as before.

FFT Options

Histogram Options
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 Data Table Options lets you control the font, size, and presentation of
data columns through two tabbed dialog boxes. The first sets the font,
weight and size of the numerals:

 Choosing Black and White in Table will disable the use of color coding
of the columns, which may make reading values somewhat easier.

Data Table Options
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 The Table Layout tab controls what columns are shown in the table.
You may want to hide some columns for clarity. The first option shows
all data. The second allows you to show just one selected run, and the
third lets you display one selected column across all runs. You can also
hide individual columns in the Column Options dialog box.

 The data columns displayed in the meter window can be set by the user
in this dialog box.

 In addition you can control the layout and font size of meter window
readouts.

Meter Window Options

Meter Layout
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 The three grid layout options determine whether the meters are laid out
to fill the available space with the largest possible meters (Automatic),
to arrange data from each run vertically (By Column) or horizontally
(By Run).

 The type size used in meters can either be set by the user or determined
automatically.

 Graph Layout allows you to control the way multiple graph panes are
shown in the graph window. Choose the desired option and click on
OK.

 There are two ways to display multiple graphs in Logger Pro; one is to
use two or more graph windows, and another is to use the Graph Layout
command to display two or more graph panes within a single window.
Graphs in separate windows are independent of one another, although
both depend on the same data table. Graph panes in a single window
share certain adjustments for ease of viewing. These shared parameters
are:

• Changing the x-axis limits in one pane will automatically change
the limits in other panes.

• Scrolling the x-axis plotting range using the scroll arrows will scroll
all panes.

• Zooming into a selected region will zoom the horizontal axis of all
panes in the same manner.

These connected adjustments will keep the horizontal axes
synchronized to allow easy comparison of each series. If you want
independent adjustment of the horizontal axes, use separate graph
windows.

 To zoom in on a portion of a graph, first draw a rectangle on the graph
screen by dragging the mouse across the desired area as you see here.

Graph Layout

Zoom In
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 Then choose Zoom In from the View menu, or click on the Zoom
In button on the toolbar. The graph will rescale, expanding the
selected region to fill the plotting area. If the Zoom In command
is used on one of several graph panes in a single graph window, the
horizontal axis will be changed in all graph panes.

 Choosing Undo Zoom will reverse the last zoom action
performed, whether by the above Zoom In command or the
following Zoom Out command. You can undo multiple zooms with
multiple Undo Zooms.

 The Zoom Out command will double the range of both the x- and
y-axes.

 Autoscale will change the scales so that the plotted curves fill the
graph area. Both x and y axes may be changed. The y axis will
not necessarily include the origin, so you may want to perform a more
limited autoscale by clicking the y axis and choosing Autoscale from
Zero in the ensuing dialog. You can also click on the Autoscale button
on the toolbar.

 Use the Sensors menu item to set up Logger Pro to work with various
sensors.6

 You will see this dialog box with three tabs. The basic sensor setup is
explained below. The Calibrate and Details tabs are described in turn.

                                                     
6 The ULI inputs can be used in combination subject to these limitations:

Port 1 cannot be used simultaneously with DG1 or DIN1.
Port 2 cannot be used simultaneously with DG2 or DIN2.
DIN3 and DIN4 cannot be used simultaneously with a Motion Detector
DIN3 and DIN4 cannot be used at sampling rates over 50Hz.
For the original ULI and ULIII (revision 1.00) the ULI Force Probe must

be used in Port 1 and the Motion Detector must be used in Port2.

Undo Zoom

Zoom Out

Autoscale

Set Up menu

Sensors
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 Sensor Setup tab

 To configure Logger Pro for a particular sensor,

� Click on the input to which you attached the sensor. For example,
DIN1, PORT2, and so forth.

� Choose the sensor name from the Sensor scrolling list. To turn off an
input, choose None from the top of the scrolling list.

� Choose the desired calibration file from the Calibration scrolling list.
Some sensors have several possible ranges or units choices. In most
cases you will use the default calibration.

 If you do not need to perform a new calibration, click on the OK button
to complete the sensor setup.

 Calibrate tab

 Analog sensors can be calibrated to report measurements in physical
units either by manual calibration, from a stored calibration file, or by
manually entering slope and intercept information (Details tab).

 Choosing Calibrate opens a dialog box allowing you to select a stored
calibration file or perform a new calibration. A new calibration requires
two independent measurements of the quantity for comparison to the
raw data readings. For example, to calibrate a temperature sensor you
must have two different water baths of known temperature.

 To perform a new calibration,

� choose Sensors from the Setup menu if the Sensor Setup window is
not already open.

� Click on the Calibrate tab at the top of the resulting dialog box.
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� Click on the input for the sensor you want to calibrate.

 If you have several sensors of the same kind you can select multiple
inputs to calibrate the sensors at the same time.

� Click on Perform Now.

� Allow the sensor and the thermometer to stabilize at the first cali-
bration temperature. You can determine this by waiting until the
displayed voltage values stop changing.

� Enter the thermometer’s actual reading (in degrees) in the Value 1
field.

� Click on Keep.

� Move the sensor and thermometer to the second water bath.

� Allow the sensor and the thermometer to stabilize at the second
calibration temperature.

� Enter the thermometer’s actual reading in the Value 2 field.

� Click on Keep.

 Calibration information is automatically saved when you save an
experiment file. As a result, it is not necessary to separately save a
calibration result unless you want the calibration to show up in the
scrolling list in the Setup Sensors tab. To make a calibration available in
the scrolling list,

� click on Save to record the calibration in a separate file.

 First calibration point

Second calibration point

Save calibration
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 You will see this dialog box.

 Enter a name for the calibration file
in the first region. The scrolling list
shows all the available calibration
files. Optionally you may enter your
initials in the Calibrated by field.
Click on OK to save the file to the
default calibration folder as
specified in Logger Pro
Preferences. You will be warned
before replacing an existing file of
your own; Vernier-supplied
calibration files may not be
replaced.

 Details tab

 Additional calibration information can be set on the Details tab of the
Sensor Setup dialog:

 

 The calibration procedure creates a correspondence between the sensor
voltage output and the measured quantity (such as temperature) which
can be characterized by a slope and intercept. If someone has done an
earlier calibration of a sensor you can manually enter the calibration
here after clicking on the Unlock button. The Labels and Units can also
be changed. For example, this is where you could enter the calibration
parameters for a new sensor that does not have a supplied calibration
file.

 The Rotary Motion Sensor is different from other sensors in that it has
modes of operation that can be controlled in software. These modes are
set in the Details tab of the Sensor Properties dialog box.

 Counts

 This field contains the number of counts a particular sensor generates
for each revolution. The Vernier/PASCO sensors generate 360 counts
for each revolution, while others may be different.

Special note for Rotary
Motion Sensor
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 Zero@Start

 The Rotary Motion Sensor can be set to zero at the start of data
collection. Enter a 1 in this field to enable automatic zeroing. Enter a 0
(zero) for conventional zeroing.

 X4 Mode

 The resolution of the Rotary Motion sensor can be set to either 1º or
0.25º. When the X4 Mode field is set to 0 (zero), resolution is 1º. When
set to 1, resolution is 0.25º.

 Diameter

 When a linear displacement calibration file is opened for a Rotary
Motion Sensor, a diameter field appears. Enter the diameter of the
rotary wheel so Logger Pro can translate the rotation of the sensor to
the displacement. The units used for diameter will be the units of the
reported displacement.

 Data Collection is used to set data acquisition parameters such as
data rate, triggering and mode. You can access the Data
Collection dialog using the toolbar as well.

 

 There are several data collection modes. They are selected from the
drop down menu on the Mode tab.

 Real Time Collect

 Data are collected at the rate indicated and for the experiment length set
on the Sampling tab.

 Repeat

 Data are collected at the rate indicated and for the experiment length set
on the Sampling tab. After a short pause, the run is repeated until the
Stop button is clicked. Usually this mode is used to acquire run after run
while an experiment is adjusted. When a useful run is acquired, press
Stop. If a new run begins before you click on the Stop button you still
can return to the previous run. Click stop, then choose Undo Collect
from the Edit menu.

 Data Collection
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 Events with Entry

 A new column is defined to replace the time column. Enter a name for
the column (Column Label), short name, and the column units. Data are
recorded only when the Keep button is clicked. Subsequently a
numerical entry field appears in the toolbar for manual entry of data.
End entries with the Enter or Return key.

 

 Selected Events

 Data are recorded only when the Keep button is clicked. No manual
entry column is created, and time is the independent variable.

 Photogate Timing

 Data are collected from a photogate or Smart Pulley. The photogate
mode supports seven methods of collecting data. The various modes are
made available on the Sampling tab of this dialog box.

 Radiation Counting

 Data are collected from a Radiation Monitor or a Student Radiation
Monitor. The Sampling tab allows the experiment length, mode and the
length of the counting time interval to be set. The Real Time Collect
mode is used for lifetime measurements, while the Events with Entry
mode is used for measuring count rates on user command, similar to the
Events with Entry mode for other sensors described above.
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 The contents of this tab are determined by the data collection mode.
When using any mode except the Events with Entry, Photogate or
Radiation Counting modes, the following Sampling dialog box will
appear:

 

 Experiment length

 Enter the length of time data over which data are to be collected. A
maximum of 30,000 points can be collected for each input channel.

 Sampling Speed

 Enter the number of measurements per time unit desired. You can also
adjust the sampling speed using the slider.

 Time

 Choose a time unit (milliseconds, seconds, minutes, hours).

 When using the Photogate mode, the following Sampling dialog box
will appear:

 

 Sampling

Photogate Sampling
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 The contents of this dialog box will depend upon the selected Timing
Mode. Pull down the Timing Mode list and choose an appropriate
mode. The Timing Device Selection portion of this dialog box is a
function of the timing mode. If the timing mode is Motion Timing,
select the type of device. If you are using a custom device, click the
User defined button and enter the distance in meters between the
leading edges of the device. In other timing modes you will only need to
enter the length of the object that passes through the gate or gates.

 When using the Radiation Counting mode, a different Sampling dialog
box will appear:

 Radiation

 Choose between Real Time Collect and Events with Entry. The Real
Time Collect mode is used for lifetime measurements, while the Events
with Entry mode is used for measuring count rates on user command,
similar to the Events with Entry mode for other sensors described
above.

 Experiment length

 Enter the length of time over which data are to be collected.

 Count Interval

 Logger Pro will count the number of pulses detected during each count
interval. For example, the settings shown above will have Logger Pro
report the number of pulses during each of sixty 5.0-s long intervals, for
a total collection time of 300 s.

 Time

 Choose a time unit.

 When averaging is set to a number other than one, the actual data
collection rate is higher than set in the sampling speed field, and up to
the indicated number of evenly spaced readings is averaged to create a
single data point. The actual number of points used may be fewer than
indicated due to sampling speed limitations of the interface. Averaging

Radiation Counting Sampling

 Averaging
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is not available for digital sensors such as the Motion Detector,
Photogates, or Radiation Monitor.

 

 Data collection can be triggered; that is, data are not collected until
certain conditions are met. To use triggering, click on the Enable
Triggering check box, and enter the desired trigger conditions. Data
collection begins when conditions are met on any one channel. When
data collection rates over 2000 points/second are used, up to 128 points
of data prior to the trigger condition can be acquired. Enter a number in
the pre-trigger field to use this function.

 

 The Interface dialog box allows you to force Logger Pro to search for a
compatible interface. The current communications channel is shown in
the drop-down menu. If no channel is chosen, the field is blank. To
choose a channel, select it from the list. That port will be scanned for an
interface. Successful communication with an interface is shown by the
identifying information; here, a ULI 2 is connected to COM1. Click on
OK to confirm the search and close the dialog. The next time Logger
Pro is started the selected port will be used. If no interface is detected
on the selected port, the OK button will change to Scan Port. Use this

 Triggering

 Interface
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button to re-scan the currently selected port, or click Cancel to leave the
dialog without searching for an interface.

 

 It is only necessary to use this dialog if Logger Pro is started without
the interface connected or powered, or if communication with the
interface is lost.

 

 New Tall Window creates a new window. The current window is halved
in width and the new window is created beside the resized active
window. A hierarchical menu, New Window has the following choices:

• Graph: Choose Graph to create a data plot.

• Table: Choose Table to create a new data table.

• FFT: Choose FFT � Graph to create a new Fast Fourier Transform
graph, or subsequently FFT Table to create an FFT table.

• Histogram: Choose Histogram � Histogram Graph to create a new
Histogram, or choose Histogram � Histogram Table to create a data
table of the histogram bin counts.

• Text: Text opens a text edit window for comments.

• Meter: Meter creates a window with digital readouts of data.

• Chart Recorder: This feature is not available in the current version of
Logger Pro.

 New Window Wide creates a new window. The current window is
halved in height and the new window is created below the resized active
window. New Menu Wide has the same hierarchical choices as the New
Tall Window command above.

 Replace Window also shares the hierarchical choice of the above
commands, but instead of generating an additional window, it replaces
the current window with the selected type of window.

 This feature is not available in the current version of Logger Pro.

 Window menu

 New Tall Window ��

New Window Wide ��

Replace
Window ��

Arrange
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 Autotile is a toggled setting. When checked it forces a tiled layout of
windows whenever a window edge is moved.

 Toolbar is a toggled setting. When checked the toolbar is visible on
screen. Uncheck it to hide the toolbar.

 The title of each open window is listed at the bottom of the Window
menu. Select the title of the window you want on top.

 Help Contents displays the table of contents for on-line help.

 Index displays the on-line help index.

 About Logger Pro shows the version number and copyright
information.

 The menu name will change to match the current experiment file.
Choosing this item will open a text entry region for storing notes about
the experiment file. When an experiment file with notes entered here is
opened the notes will be displayed.

Autotile

Toolbar

1 Table Window

Help menu

Contents

Index

About Logger Pro

About (pH System)
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Appendix A
Troubleshooting Guide

Problem Cause Solution
Logger Pro cannot find the
Interface

ULI or Serial Box Interface not
correctly connected to computer

Connect interface to the modem or
printer port (Macintosh) or COM1,
COM2, COM3 or COM4 (PC) using
supplied cable.

Two or more copies of Logger
Pro running

Exit all but the first copy of Logger
Pro.

Bad interface cable Replace interface cable
Wrong serial port being used Make sure you are using the correct

serial port. For example, don’t
confuse COM1 and COM2 (PC) or
the Printer and Modem ports (Mac).

Interface not receiving power
(green light off) or not turned on.

Make sure the power adapter is
plugged into a wall socket and
connected to the interface.
Turn on power switch (ULI only).

Battery-powered Serial Box has
dead batteries

On the Serial Box Interface, make
sure the green LED comes on when
you start up Logger Pro.

Modem port of Macintosh not
available

If you are using a Macintosh with an
internal modem, make sure that the
control panels are set for external
modem.
If you are using a Macintosh
PowerBook with a single
modem/printer port and are not
using Ethernet port, AppleTalk must
be turned off to make port available.

Computer’s serial port is set up
for internal modem use. (This is
a potential problem for any
computer with an internal
modem.)

Reconfigure the serial port for use
with an external modem.

Serial port of PC disabled If you are using a laptop PC, make
sure the serial port is not disabled by
a power-saving mode.

Modem or serial port in use by
another program

Quit any other program that could
be using the port.
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Problem Cause Solution
The mouse locks up as Logger
Pro starts up

Logger Pro and a serial mouse
conflict (PC)

Hold down the Ctrl key during start
up. The program will not
automatically search for the
interface. Click on the correct COM
port for the ULI.

Cannot save a previously
opened experiment file

File has been opened in read-
only mode (default).

Clear read-only check-box when
first opening file, or save the altered
file under a new name.

Sensor not working Sensor connected to the wrong
port.

Make sure the sensor is connected to
the correct connector. Refer to the
Sensor Setup in Logger Pro.

Two sensors connected to the
same input line of the ULI.

Never use more than one sensor
connected to each voltage input at
the same time. For example, if you
are using the DIN 1 socket, do not
use the Port 1 modular phone
connector at the same time.

Sensor faulty Try a different sensor. You might
want to try measuring the voltage of
a battery with the Voltage Probe.

No data appearing in graph Graph range defined too small
for data to appear

Select Autoscale or double-click on
the graph and select a larger range of
values for the axes.

Readings are noisy Interface is picking up
interference from the computer

Place the interface at least 30 cm
away from the computer.
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Appendix B
Using Logger Pro on a Network

 If your computers are served software from a central file server on a
network, you can install Logger Pro on the server. Create a folder on the
server to hold Logger Pro (you will need sufficient privileges7 to do
this). Run the Logger Pro Installer from the floppy disk, and specify the
file server folder when the installer asks for the desired location for
Logger Pro. Set the student access rights to the Logger Pro folder to
read-only and shareable. Then students can see and run Logger Pro, but
cannot change it.

 Logger Pro will read a preferences file in its own directory on startup.
This file indicates the location all calibration files and the default
location of experiment files. If you want students to use a standard set
of calibration and experiment files, the files should be stored on the
server in a location to which students have the same access privileges as
the Logger Pro program itself. The preferences must then be set to
indicate the location of these files on your server. When you set the
preferences, you must have write access to make changes to the
preferences, experiment, or calibration files.

 Two good choices for the location of experiment files are 1) A protected
directory on the file server where the students cannot make changes; or
2) A local directory where students can store their own files. In the first
case students must be directed to save files to another directory; in the
latter, experiment files must be placed on each computer and could be
changed inadvertently. To avoid accidental changes, set file attributes to
Read-only (Windows, right-click on file to see dialog) or to Locked
(Macintosh, select file, choose Get Info to see dialog). This way you
can have a reference set of experiment files while students can still save
their own files.

 Similarly, calibration files can be stored either centrally on the server or
on individual machines. If your students will use a common set of
calibration files, then choose the former. For the less common case of
individually calibrated sensors (custom calibration done for a specific
sensor/interface/computer combination), then the calibration files must
be stored locally since they will be different for each computer. Lock or
set to read-only those files you do not want changed.

 To use the network copy of Logger Pro on networked computers, log in
to the file server so the server’s icon is on the Macintosh desktop.
Locate the Logger Pro icon, and double-click to start. For simplicity,
create an alias for Logger Pro on the local hard disks. Then, when the
alias is double-clicked, the user will be prompted to log in, the file
server disk will be mounted and Logger Pro will start.

 To use the network copy of Logger Pro on networked computers, log in
to the file server and navigate to the Logger Pro icon. Double-click on it
to start. As a shortcut in Windows 95, you may want to drag the Logger

                                                     
7File servers provide some security by only allowing certain users to perform
functions like saving, modifying, or deleting files in certain directories.
Typically only administrative accounts are allowed to make changes anywhere
on the server—one speaks of having the privilege or right to make these
changes.

General principles

Logger Pro preferences

Macintosh

Windows
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Pro icon to the Start menu to place Logger Pro in the Start menu list. In
Windows 3.1x you can create a program group and item for Logger Pro.

 For your students to use Logger Pro on a network, they first must have
adequate access rights. Student access should allow Logger Pro to be
seen and executed, but not changed in any way. Your network
administrator should be able to assist in this setting.

Student use of Logger Pro
on a network
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Appendix C
Interfaces Compatible with Logger Pro

 You can use either the Universal Lab Interface (ULI) or the Serial Box
Interface with Logger Pro. The two interfaces differ in capability, but
often either can be used. While the ULI can do almost everything the
Serial Box Interface can do while adding higher speed and digital
inputs, the ULI is more expensive. The table below will give you the
details so you can decide which interface to use in your experiments.

 Interface  Cost  Data Rate  Sensors  Use in…

 Serial Box
Interface

 $99

 $59 for
Logger Pro
software or
$30 for Data
Logger (both
include site
license)

 As fast as 50
readings per
second

 Two analog inputs
to use with
temperature,
voltage, pH,
pressure, force,
colorimetry, light,
heart rate, EKG,
dissolved oxygen,
conductivity,
magnetic field, and
others.

 Chemistry
Biology
Physical Science
Middle School
Integrated Science
Earth Science

 Universal
Lab Interface

 $299

 $59 for
Logger Pro
software or
$49 for ULI
Software
Package8

(both include
site license)

 As fast as
11,000
readings per
second

 Four analog and two
digital ports to use
with all of the above
plus motion, ULI
Force, photogate,
radiation

 all of the above plus
Physics

 

 The Serial Box Interface offers the advantage of battery operation. The
Smart Battery Holder (SBI-BAT, $29) allows battery operation of the
Serial Box Interface, and is an ideal match to a portable computer for
field work.

                                                     
8Contains Data Logger, Motion, and Sound for Macintosh or MS-DOS, plus
ULI Timer (Mac only) .

ULI or Serial Box Interface?

Battery operation
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Appendix D
Sensors for use with Logger Pro

 You can use many different Vernier sensors with Logger Pro. The
Logger Pro package includes calibration files for these sensors. Most
sensors can be used with either the ULI or the Serial Box Interface;
others can be used only with the ULI.

 These sensors can be used with Logger Pro and either a Serial Box
Interface or a ULI:

� 25-g Accelerometer

� Barometer

� Biology Gas Pressure Sensor

� CO2 Gas Sensor

� Colorimeter

� Conductivity Probe

� Direct-Connect Temperature Probe

� Dissolved Oxygen Probe

� Dual-Range Force Sensor

� EKG Sensor

� Exercise Heart Rate Monitor

� Extra Long Temperature Probe

� Flow Rate Sensor

� Heart Rate Monitor

� Ion-Selective Electrodes

� Light Sensor

� Low-g Accelerometer

� Magnetic Field Sensor

� pH System

� Pressure Sensor

� Relative Humidity Sensor

� Standard Temperature Probe

� Student Force Sensor

� Thermocouple

� Voltage Probe

 In addition, if you are using the ULI, you can also use the following
sensors.

� Motion Detector

� ULI Force Probe

� Radiation Monitor or Student Radiation Monitor

Sensors supported by both
the Serial Box Interface and
ULI

Sensors for the ULI only
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� Rotary Motion Sensor

� Microphone

� 3-Axis Accelerometer

 Experiment files for all supported sensors are supplied with the Logger
Pro package. These experiment files will automatically load Vernier
calibration files for use with these sensors, although other calibration
files may be chosen.

 After loading a sensor’s experiment file, Logger Pro will display
appropriate units for that sensor.

Additional Sensor Information

 The remainder of Appendix D consists of a list of sensors compatible
with Logger Pro, accompanied by short descriptions of their
capabilities.

 Each Vernier sensor is sold with a comprehensive data sheet which
explains specific sensor characteristics, gives calibration information,
and suggests experiments to be performed. Consult the data sheet for
the particular sensor for additional information.

 Our 25-g Accelerometer is great for studying collisions or centripetal
acceleration and any situation with fairly large accelerations. Range
� 250 m/s2 (� 25g).

 Our 3-Axis Accelerometer is really three low-g accelerometers mounted
at right angles and all placed in a small box. Use it for studying the
complex motion of an amusement park ride, a bungee jumper, or simply
a toss in the air. With most our data collection programs, you can graph
the magnitude of the acceleration vector.

 Our Barometer can be used for weather studies or for lab experiments
involving pressures close to normal air pressure. The pressure range is
24 to 32 inches of Hg (0.8 to 1.05 atm) absolute pressure.

 Use the Biology Gas Pressure Sensor to monitor gas-pressure changes
due to respiration or transpiration. It can also be used as a standard
barometer for monitoring air pressure. It can even be used to investigate
pressure-volume or pressure-temperature experiments in chemistry. This
sensor has a pressure range of 0.75 to 1.5 atm.

 The CO2 Gas Sensor measures gaseous carbon dioxide levels in the
range of 0 to 5000 ppm. This probe is great for measuring changes in
CO2 levels during plant photosynthesis and respiration. With this
sensor, you can easily monitor changes in CO2 levels occurring in
respiration of organisms as small as crickets or beans! The CO2 Gas
Sensor is easily calibrated using a calibration button. A chamber with
probe attachment is included for running controlled experiments with
small plants and animals.

 This is a 3-color (red-635 nm, green-565 nm, blue-470 nm) colorimeter.
It is great for Beer’s law experiments, determining the concentration of
unknown solutions, or studying changes in concentration vs. time.
Fifteen 3.5-mL cuvettes are included. A package of 100 replacement
cuvettes is available.

 Excellent for environmental testing for salinity, total dissolved solids
(TDS), or conductivity in water samples. Biology teachers can use this
sensor to demonstrate diffusion of ions through membranes or to

Experiment and calibration
files

Sensor data sheets

25-g Accelerometer

3-Axis Accelerometer

Barometer

Biology Gas Pressure Sensor

CO2 Gas Sensor

Colorimeter

Conductivity Probe
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monitor changes in ion levels in aquatic systems. Chemistry students
can use it to investigate the difference between ionic and molecular
compounds, strong and weak acids, or ionic compounds that yield
different ratios of ions. The Conductivity Probe can monitor
concentration or conductivity at three different sensitivity settings
covering 0-10,000 mg/L TDS (0-20,000 µS).

 Use our Current & Voltage Probes to monitor currents and voltages in
DC and AC circuits with the ULI, SBI, or CBL. The system consists of
an amplifier box, two current probes, and two voltage probes. Any
combination of two probes can be used at once. The voltage range is
�6 V (wider than with our Voltage Probe) and is a true differential
input. The current range is �0.6 A.

 This is our most popular temperature probe. It has a Teflon-coated brass
tube with a temperature sensor at the end. It can be used in a wide
variety of chemicals with a temperature range of –15 to 110°C (±0.2°C
in normal use).

 Use the Dissolved Oxygen Probe to determine the concentration of
oxygen in aqueous solutions in the range of 0-15 mg/L (ppm). It has
built-in temperature compensation and a fast response time This sensor
is great for biology, chemistry, ecology, or integrated science courses.
Included with the sensor is an amplification box, zero-oxygen solution,
two membrane caps, a 100% calibration bottle, and electrode filling
solution. Replacement membrane caps are available.

 This low-cost force sensor has two ranges. It can be easily mounted on a
ring stand or dynamics cart, or used as a replacement for a hand-held
spring scale. Use it to study friction, simple harmonic motion, impact
collisions, or centripetal force. It can be used with any of our lab
interfaces or CBL.

 The EKG Sensor measures electrical signals produced by the heart. It
uses three disposable electrode patches. An EKG graph is displayed,
demonstrating to students the contraction and relaxation of the heart’s
chambers. A package of 100 disposable electrodes is included with the
sensor.

 The Exercise Heart Rate Monitor is ideal for determining the heart rate
of moving or active individuals. With this sensor, a person’s heart rate
can be monitored during, as well as after exercise. The Exercise Heart
Rate Monitor consists of a wireless transmitter belt and a receiver
module that plugs into a Vernier interface box or CBL. The transmitter
belt senses the electrical signals generated by the heart much like an
EKG. For each heart beat detected, a signal is transmitted to the plug in
the receiver module, and a heart rate is determined.

 The Flow Rate Sensor is used to measure stream velocity for
environmental or earth science studies. Using flow rate data, your
students will be able to calculate discharge value for the stream in ft^3/s
or m^3/s, or determine the sediment transport of the stream. The
impeller rod separates into four sections for easy transport and
convenient storage. The Flow Rate Sensor comes equipped with a five-
meter cable so your data collection equipment can stay on shore while
you measure flow rate in the stream. Three riser rods are included with
each sensor, which enable the impeller to be placed at fixed depths.

 The Vernier Heart Rate Monitor measures human pulse rate. Simply
attach the Heart Rate Monitor’s earclip to your ear lobe, and your pulse
rate is displayed on the computer monitor. Heart Rate Monitor  program
(Macintosh or MS-DOS versions included free on the Data Logger disk)

Current & Voltage Probes
System

Direct-Connect Temperature
Probe

Dissolved Oxygen Probe

Dual-Range Force Sensor

EKG Sensor

Exercise Heart Rate Monitor

Flow Rate Sensor

Heart Rate Monitor
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displays the heart-beat waveform, pulse rate in beats/minute, data table,
statistics, and a graph of pulse rate vs. time.

 The Instrumentation Amplifier will monitor voltages from a few
millivolts (DC or AC). It has several ranges to allow you to select the
most appropriate gain: 0-20 mV, 0-200 mV, 0-1 V, ±20 mV, ±200 mV,
and ±1 V. The amplifier has a true floating differential input, unlike the
DIN ports of the ULI. It can be used with any of our computer lab
interfaces, as well as the Texas Instruments CBL.

 We have a family of solid-state and PVC membrane ion-selective
electrodes: Nitrate (NO3

–), Chloride (Cl–), Calcium (Ca2
+), and

Ammonium (NH4
+). These electrodes require the Ion-Selective

Electrode Amplifier (ISE-DIN) for connection to the ULI.

 Our Light Sensor approximates the human eye in spectral response and
can be used over three different illumination ranges, which you select
with a switch. Use it for inverse square law experiments or for studying
solar energy. The ranges are 0-600, 0-6000, 0-150,000 lux.

 This sensor measures acceleration in the range of ±50 m/s2 (±5 g). It has
a flexible 2-meter cable. It is useful for studying motions with smaller
accelerations, like cars (real and toy), elevators, and amusement park
rides.

 This sensor, which uses a Hall Effect transducer, is sensitive enough to
measure the earth’s magnetic field. It can also be used to study the field
around permanent magnets, coils, and electrical devices. Its two ranges
are ±3.2 x 10-4 tesla and ±6.4 x 10-3 tesla.

 The Motion Detector functions like the automatic range finder on a
Polaroid camera. This sonar device emits ultrasonic pulses at a rate
adjustable between 10 and 50 times per second. The time it takes for the
reflected pulse to return is used to calculate distance, velocity, and
acceleration. The range is 0.5 to 6 meters. We have versions for use
with the MPLI, ULI or CBL.

 Our pH System includes a pH Electrode and pH Amplifier. The pH
Electrode is a Ag-AgCl combination electrode with a range of 0 to 14
pH. The pH Amplifier contains the signal-conditioning circuitry. The
Electrode is also available separately.

 Our Pressure Sensor has a range of 0 to 100 psi (0 to 6.8 atm) absolute
pressure. It is designed for gas law experiments in chemistry, physical
science, and physics. A plastic syringe and tubing are included for use
with Boyle’s law experiments.

 The Radiation Monitor was adapted for the Workshop Physics courses
at Dickinson College. It consists of a Geiger-Mueller tube and rate
meter mounted in a small, rugged, plastic case. The unit is battery
operated and can be used with or without a computer for measurement
of alpha, beta, and gamma radiation.

 We also have a low-cost Student Radiation Monitor for monitoring beta
and gamma radiation. It consists of a Geiger-Mueller tube mounted in a
small, rugged case. It can be used to measure the total number of counts
per specified timing interval. Your students can investigate topics such
as shielding, inverse square law, and half-life.

 The Relative Humidity Sensor contains an integrated circuit that can be
used to monitor relative humidity over the range 0 to 95% (±5%). Use
this sensor for weather studies, monitoring greenhouses, or for
determining days when static electrical discharges could be a problem.

Instrumentation Amplifier

Ion-Selective Electrodes

Light Sensor

Low-g Accelerometer

Magnetic  Field Sensor

Motion Detector

pH System

Pressure Sensor

Radiation Monitors

Relative Humidity Sensor



 Appendix D

Logger Pro 91

 Our Respiration Monitor Belt is used together with our Biology Gas
Pressure Sensor to measure respiration. Simply strap the belt around
your chest, then pump air into the belt with the hand bulb, providing as
much pressure as desired. You can then monitor the pressure associated
with the expansion and contraction of the chest during breathing. This
accessory is great for biology, physiology or life science courses.
Requires the BGP-DIN sensor.

 The Rotary Motion Sensor monitors angular position with a resolution
of 0.25 degrees. The sensor is direction sensitive. Logger Pro will
calculate angular velocity and acceleration from the position data.
Linear position can also be measured to sub-millimeter resolution.

 This system has a signal-conditioning box and probe with the same
Teflon coating as the Direct-Connect Temperature Probe. The system
has a range of –50 to 150°C. The probe can be disconnected from the
box and replaced with a variety of replacement temperature probes:

� Standard Temperature Replacement Probe

� Quick-Response Temperature Replacement probe. The smaller,
ceramic sensor for this probe means the probe can respond more
quickly to changes in temperature. It is, however, much less protected,
both chemically and physically. We recommend it for air and water
only and in situations where extremely quick response is necessary.

� Extra Long Temperature Probe. See the description of this probe
below.

 This is the same as our Standard Temperature Probe System, but the
probe has a 30-meter (100 ft) cable. This probe is designed for remote,
outdoor temperature sensing or for measuring temperature at various
depths in lakes or streams.

 This sensor uses type-K thermocouple wire to measure the difference in
temperature between its two junctions. It can be used over the range –
200 to 1400°C (±10°C). It can be used to study flame temperatures.

 This strain gage force measurement device can measure forces from
0.05 to 10 newtons or more (push or pull). The range can be changed by
adjusting a screw. It can be mounted on a ring stand or used as a
replacement for a hand-held spring scale. Use it to study friction, simple
harmonic motion, impact in collisions, or centripetal force.

 One set of test leads with red (positive) and black (ground) leads is
included with the Serial Box Interface and the ULI. Use these leads for
direct voltage measurement.

Sensor Price List
Sensor/Probe Price/Order Code

25-g Accelerometer $99 (ACC-DIN)

3-Axis Accelerometer $199 (3D-DIN)

Barometer $56 (BAR-DIN)

Biology Gas Pressure Sensor $68 (BGP-DIN)

CO2 Gas Sensor $259 (CO2-DIN)

Colorimeter $99 (COL-DIN)

Conductivity Probe $79 (CON-DIN)

Respiration Monitor Belt

Rotary Motion Sensor

Standard Temperature
Probe System

Extra Long Temperature
Probe

Thermocouple

Student Force Sensor

Voltage Probe
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Current & Voltage Probes $84 (CV-DIN)

Direct-Connect Temperature Probe $28 (DCT-DIN)

Dissolved Oxygen Probe $189 (DO-DIN)

Dual-Range Force Sensor $98 (DFS-DIN)

EKG Sensor $175 (EKG-DIN)

Exercise Heart Rate Monitor $89 (EHM-DIN)

Extra Long Temperature Probe $68 (TPL-DIN)

Heart Rate Monitor $47 (HRM-DIN)

Ion-Selective Electrode Amplifier $39 (ISE-DIN)

Ion-Selective Electrodes (requires ISE-DIN)
(NO3

–, Cl–, Ca2+, NH4
+)

$149 each

Instrumentation Amplifier $49 (INA-DIN)

Light Sensor $39 (LS-DIN)

Low-g Accelerometer $88 (LGA-DIN)

Magnetic Field Sensor $44 (MG-DIN)

Motion Detector $65 (MD-ULI)

pH System $72 (PH-DIN)

Photogate Parts Kit9 $9 (PGK-DG)

Pressure Sensor $69 (PS-DIN)

Radiation Monitor $199 (RM-DG)

Relative Humidity Sensor $65 (RH-DIN)

Respiration Monitor Belt
(Requires Biology Gas Pressure Sensor)

$58 (RMB)

Rotary Motion Sensor $185 (CI-6625)

Standard Temperature Probe $43 (TPA-DIN)

Student Force Sensor $99 (SFS-DIN)

Student Radiation Monitor $138 (SRM-DG)

Thermocouple $35 (TCA-DIN)

ULI Force Probe $130 (FP-ULI)

ULI Microphone $30 (MCA-ULI)

Vernier Photogate (Assembled) $39 (VPG-DG)

Voltage Probe
(One included with ULI)

$7 (TL-DIN)

                                                     
9For a ULI purchased prior to 1995, order the 2-Photogate Parts Kit

(2PUL, $38).
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Index
 

A

About Run · 56
Add Zero Button · 54
Advanced tutorials · 13
Analysis functions · 31
Analyze menu · 58
Arrange · 79
Arrange windows · 16
Autoscale · 15, 70
Averaging · 23, 77
Axis labels · 48

B

Bar graph · 17, 64
Battery · 85

C

Calibration · 19
Calibration files · 45
Calibration files, default location · 51
Change graph appearance · 15
Chart recorder · 30
Clear · 53
Clear All Data · 58
Close · 50
Collect · 53
Collection · 74
Collection rate · 76
Column Options · 58
configuration, total · 18
Configure sensors · 18
Connecting line (graphs) · 64
Copy · 53
Correct entries · 28
Creating an experiment file · 45
Curricular material · 44
Cursor controls · 47
Curve Fit · 59
Cut · 52

D

Data averaging · 77
Data collection rate · 22, 76, 77
Data menu · 55
Data table functions · 34
Data Table Options · 67
Delete Column · 58
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Delete Run · 55
Digital readout · See Meter window

E

Edit cell contents · 49
Edit menu · 52
Enter data manually · 37
Events with Entry · 24, 75
Examine · 59
Experiment files · 44
Experiment files, default location · 52
Experiment length · 22, 76, 77
Experiment menu · 53
Export data · 38
Export Data · 50

F

FFT · 29
FFT Options · 66
File menu · 50
Fit other functions · 31

G

Graph Layout · 69
Graph Options · 64
Graph title · 48
Graphical Analysis · 37
Grid · 17, 65

H

Help menu · 80
Help Topics · 80
Hide Run · 55
High Pass Filtering (FFT) · 66
Histogram · 29, 66
Histogram options · 66
How To … · 15

I

Import Data · 50
Installation · 41
Integral · 63
Interface · 78
Interpolate · 33, 59
Introductory tutorials · 13

K

Keystroke Equivalents · 46
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L

Legend · 17, 64
Linear Fit · 59
Linear regression · 31
Live readouts · 54

M

Manual data entry · 37
Manual Fit · 61
Menus · 50
Meter layout · 68
Meter window · 30
Meter window options · 68
Model (Manual Fit) · 61
Modify Column · 58

N

Network use · 83
New · 50
New Column · 56
New columns · 35
New Window Tall · 79
New Window Wide · 79

O

Over Range Autoscale · 52

P

Page setup · 51
Paste · 53
Photogate · 25, 75
Photogate sampling · 76
Plot one probe versus another · 16
Point protector · 64
Point protectors · 17
Preferences · 38, 51
Print · 51
Print Preview · 51
Printer setup · 51
Printing · 38
Prompted data acquisition · 24
Protecting experiment files · 44

Q

Quick Start · 10
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R

Radiation counting · 27, 75
Radiation counting sampling · 77
Real time data collection · 21
Remove a sensor · 20
Repeat mode · 22
Repeat mode of data collection · 74
Replace Window · 79
Replay · 53
Rescale · See Autoscale
Rotary Motion Sensor · 73

S

Sampling speed · 22, 76, 77
Save As… · 50
Save calibration · 20
Save data · 38
Scroll · 16
Scroll arrows · 48
Select All · 53
Selected Events · 75
Selected Events Collection Mode · 24
Sensor information · 88
Sensors · 70
Set Up menu · 70
Show Run � · 55
Smoothing · 23, 54
Software installation · 42
Sort data · 28
Sort Data · 56
Spreadsheet, copying data to · 37
Statistics · 63
Stop · 53
Store Latest Run · 55

T

Table layout · 68
Table options · 34
Tangent · 31, 59
Teacher’s Guide · 41
Text window · 29
Tick mark labels · 48
Time unit · 76, 77
Time units · 22
Toolbar · 47, 80
Triggering · 24, 78
Troubleshooting · 81
Turn off input · 20

U

Undo · 52
Undo Zoom · 70
Units · 16
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V

View menu · 63

W

Window menu · 79
Window types · 29
Windowing (FFT) · 66
Windows · 29

Z

Zero · 55
Zero Button · 54
Zoom · 15
Zoom In · 69
Zoom Out · 70
 


